
Moving you from Meek to Geek in a Nanosecond (or two)©! 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Prepared especially for You! 

 

Presented and Written by: 

Greg Creech 
Techedutainment Services Inc. 

Technology  Education  Entertainment 

Hey! It’s Chic 2B Geek© Series! 
Excel for Excellent Business Management 



Page 2 Excelling at Excel: The FUNdamentals Level 1  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2017 
No Duplication Permitted  404-403-5391 

An Excellent Table of Contents  
  

An Excellent Table of Contents ..................................................................................................... 2 

Oops! and Legal Stuff .................................................................................................................... 5 

Introducing Greg Creech ............................................................................................................... 6 

Welcome to Excelling at Excel ...................................................................................................... 7 

Welcome! To Excel ........................................................................................................................ 8 

Worksheet Window ................................................................................................................................ 9 

My Favorite Excel Shortcuts ............................................................................................................... 15 

Important Tips to make your Excel Experience Easier .................................................................... 16 
Resizing columns and rows ................................................................................................................................ 16 
Rename a Worksheet ......................................................................................................................................... 16 
A Hot Tip! Status Bar and Calculations ......................................................................................................... 17 
Go To and Scrolling Bars ................................................................................................................................... 18 

Customizing Excel for Productivity ............................................................................................. 20 

Quick Access Toolbar Options and Customization ........................................................................... 20 

Tabs and The Ribbon Shortcuts .......................................................................................................... 28 

Keyboard Shortcuts and Key Tips ...................................................................................................... 31 

File Management ......................................................................................................................... 35 

Open and Recent Files .......................................................................................................................... 36 

The Five F’s of Excel................................................................................................................... 38 

F1:  Formatting for Appearances Sake .............................................................................................. 39 
Formatting Groups ............................................................................................................................................. 41 

The Merge and Center ................................................................................................................................... 41 
Font Group .................................................................................................................................................... 43 
Format Cells Dialogue Box:  Font................................................................................................................. 43 
Alignment Dialogue Box and Group ............................................................................................................. 44 
Number: Format Cells Dialogue Box and Group .......................................................................................... 45 

Important Tips to make your Formatting Experience Easier .......................................................... 47 
Themes ............................................................................................................................................................... 47 
Format Painter .................................................................................................................................................... 48 
Cells Group ........................................................................................................................................................ 49 
Undo ................................................................................................................................................................... 50 
Insert and Hiding Columns and Rows ................................................................................................................ 50 
Comments .......................................................................................................................................................... 51 

F2:  Filler’ up with the AutoFill Handle! ............................................................................................ 55 
Fill with Months and Weekdays......................................................................................................................... 55 
Months ............................................................................................................................................................... 56 

Days............................................................................................................................................................... 56 



Greg Creech Excelling at Excel: The FUNdamentals Level 1  Page 3 

www.gregcreech.com 

Greg Creech © 2017 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Filling in a series of Numbers ............................................................................................................................ 57 
Consecutive Numbers.................................................................................................................................... 57 
Multiples of a Number .................................................................................................................................. 57 
Text with a Number ....................................................................................................................................... 58 

Filling in Dates ................................................................................................................................................... 58 
Consecutive Dates ......................................................................................................................................... 58 
Bi-Weekly or other Weekly Dates ................................................................................................................ 58 
Monthly Dates ............................................................................................................................................... 59 
Relative Dates ............................................................................................................................................... 59 

Flash Fill ................................................................................................................................................ 61 

F3: Forming our Formulas .................................................................................................................. 63 
Mathematical Operators ..................................................................................................................................... 63 
Symbols in Formulas and Functions .................................................................................................................. 64 
Cell Referencing and Addressing ....................................................................................................................... 65 

Relative Address ........................................................................................................................................... 65 
Absolute Address .......................................................................................................................................... 65 
Mixed Address .............................................................................................................................................. 65 
3-D References .............................................................................................................................................. 65 

F4: Putting the Fun into  “Fun”ctions ................................................................................................ 68 
AutoSum ............................................................................................................................................................ 68 
Other Functions .................................................................................................................................................. 71 

F5:  Filters and Sorts ............................................................................................................................ 74 
Excel Database ................................................................................................................................................... 74 
Filter through A List .......................................................................................................................................... 75 
Multiple Filters ................................................................................................................................................... 80 
Top 10 ................................................................................................................................................................ 81 
Custom Filters .................................................................................................................................................... 83 

Number Custom Filters ................................................................................................................................. 83 
Text Custom Filter ........................................................................................................................................ 84 
Date Custom Filters ....................................................................................................................................... 85 
Yes/No Filter ................................................................................................................................................. 86 

Sorting ................................................................................................................................................................ 87 
Sorting Command Buttons: A Single Sort .................................................................................................... 88 
Custom Sort: Sorting by Multiple Items ....................................................................................................... 90 

Quick Analysis.............................................................................................................................. 93 

Worksheet Organization .............................................................................................................. 94 

Worksheet Efficiencies and Navigation .............................................................................................. 94 
Worksheet Tabs and Shortcuts ........................................................................................................................... 94 

Isn’t that Special? The Copy Cat, Clear, Paste Preview and Paste Special ............................ 101 

Home Tab Command Buttons ........................................................................................................... 102 

Keyboard Shortcut ............................................................................................................................. 102 

Right Click or Shortcut Menu ........................................................................................................... 102 

Click and Drag .................................................................................................................................... 103 
(Best for small amounts of data that will not be moved or copied to another worksheet  or distant 

locations) ................................................................................................................................................ 103 



Page 4 Excelling at Excel: The FUNdamentals Level 1  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2017 
No Duplication Permitted  404-403-5391 

Paste Preview and Paste Special ........................................................................................................ 104 

It’s A Setup! Views, Page Layout and Printing ........................................................................ 107 

Freeze those panes Or I have a Splitting Pane ................................................................................. 107 

Whose Zoomin’ who? And other view options ................................................................................ 110 
Switching and Arranging ................................................................................................................................. 110 
Zooms .............................................................................................................................................................. 111 
New Window and Hide .................................................................................................................................... 111 

Print Preview and Print ..................................................................................................................... 112 

Page Layout and Page Setup ............................................................................................................. 115 
Page Layout Tab .............................................................................................................................................. 115 
Margins ............................................................................................................................................................ 117 
Header/Footer................................................................................................................................................... 118 
Sheet Options and Print Areas ......................................................................................................................... 122 

Gimme a Break - Page Breaks ........................................................................................................... 125 

Print Preview and Printing ................................................................................................................ 127 

An Excellent Excel Index .......................................................................................................... 128 



Greg Creech Excelling at Excel: The FUNdamentals Level 1  Page 5 

www.gregcreech.com 

Greg Creech © 2017 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Oops! and Legal Stuff  

 

While I have made every effort to ensure the accuracy of this document, including grammar and 

instructions, I make mistakes. (Surprise!)  If you find an error or want to provide constructive 

feedback, please contact me.  Thank you!  Enjoy Excelling at Excel and this document. 

 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

www.gregcreech.com 

 

✓ International Association of Administrative Professionals Member/Partner 

✓ Association of Talent Development 

✓ Society for Human Resource Management 

✓ Microsoft Certified Application Specialist – Instructor 

✓ Certified Technical Trainer + - CompTIA 

✓ A+ Certified through CompTIA 

✓ Microsoft Certified Technical Trainer 

 

Excel ® is a most excellent product from Microsoft ® Corporation and is part of the Office ® 

Suite of products and services.  

 

Copyright © 2017 Greg Creech, Techedutainment Services, Inc.  All rights reserved.  This 

publication, or any part thereof, may not be reproduced or transmitted in any form or by any 

means, electronic or mechanical, including photocopying, recording, storage in an information 

retrieval system, or otherwise, without express written permission of Greg Creech, P. O. Box 

1431, Pine Lake, GA  30072-1431, www.gregcreech.com. 

http://www.gregcreech.com/
http://www.gregcreech.com/
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Technology  

speaker and  

trainer Plus, 

he’s a   

pianist and 

comedian. 
 

Greg Creech 
sings to his 
students, and 
often he performs 
stand-up comedy 
about computers. 

Introducing Greg Creech 

Shop Talk from The Atlanta Journal-Constitution 
Sunday, Oct. 29, 2000 R3 - JOBS 

Why I Love my Job – Greg Creech 
What I Do: I teach technology courses and make presentations to beginner and expert computer 

users and professionals.  I use humor and the piano.  I train all levels from first-time computer users to 

systems technicians acquiring A+ certification.  As an A+ 

certified trainer, MOUS expert, and technical trainer, my 

certifications and knowledge give me a career in the 

technology.  My humor, the piano, and people keep me in the 

technology training field. I sing to my students sometimes and 

perform stand-up comedy about computers. 

How I got started:  I won Best Actor in a Supporting Role at 

Southside Theatre Guild for “A Funny Thing Happened on the 

Way to the Forum” and studied comedy under Jerry Farber.  I 

have played the piano since 8 years of age and had the first 

personal computer with a 1 MB of memory.  In order to learn 

the PC, I associated the PC with the piano  -- both use a 

language to translate, both have keyboards, and now - both 

provide music and information.  I must admit I miss the days 

when I only played the piano and programmed the PC.  Now, I 

play the PC and have to program my piano.  In 1998 after 

seventeen years of technology business experience in the 

corporate market, I decided to take a leap of faith on my own. 

I call my presentations “Showminars,” a combination of a 

show and a seminar. 

The Best Part:  Hearing the laughter and the comments:  

“You have saved me so much time,” and “I remember 

complicated macros because of the way you taught them.” I have a passion for 

teaching creative people to be more technical and technical people to be more 

creative – Mozart would be proud! 

The Challenging Part:  Explaining why I want my piano in a PC classroom.  

“Mainframers” who refuse to acknowledge the existence of the PC and the 

Web.  People who attend training classes because they have to, not because 

they want to.  Technical people who are not client- focused. 

My Favorite Quotes:  “To err is human, to really mess things up you need a 

computer.”  “Forty-two percent of all households have a computer; only eight 

percent of those know how to use it.”  

What Keeps me Going:  I enjoy combining my love of people, the piano, processors, and humor into a 

unique speaking and learning experience. 
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Welcome to Excell ing at Excel  
 

Welcome to your course that will lead to “Excellence” at Excel.  I have used spreadsheets and 

predecessors to Excel since 1980.  I have used Excel from the inception of the program.  As an 

Operations Manager, Sales Support person, and Administrative Manager I have used and abused 

Excel, and Excel has used and abused me.  Properly using Excel can be tricky and troublesome, 

but once you master the navigation in Excel and the powerful formula and functions your 

professional and personal life of number crunching will be much easier and more productive. 

First, we will examine how to maneuver in Excel and some of the important efficiencies in Excel 

viewing an existing spreadsheet.  We’ll examine the user interface in Excel and the Ribbon as 

well as new features and productivity in the new version. We will learn many shortcuts 

throughout the course. 

Second, we will learn the 5 – Fs of Excel as we construct our own Monthly and Annual Budget 

and Expenses worksheets.  The 5 Fs are: 

✓ Formatting, 

✓ Fills, 

✓ Formulas, 

✓ Functions, 

✓ Filters and Sorts. 

 

The purpose of this course it not only to teach you but also to increase your productivity, because 

as we learn we will be building your personal or professional budgeting system using your data.  

I will provide guidance in class and in the document to assist you; however, the data is yours and 

your application will save you time and energy. 

Again, Welcome.  Let’s have fun and learn (flurn) together. Let’s begin Excelling at Excel. 
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Welcome! To Excel   

Let’s look at Excel’s main window and components of the interface. 

1. Open Excel. Excel will present a blank Worksheet ready for you to 

begin or Excel may provide a screen for you to use templates or open 

other files, as displayed below for you.  In any event, create a new 

blank workbook by clicking the Blank workbook item. 

2. Pictured below is the Worksheet Window for Excel 2013/2016. The 

pane at the left part of your screen has your pinned and recent files 

providing quick access to your frequent workbooks.  

3. Let’s take a tour of your Worksheet Window. 
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1. The File Tab, Quick Access Toolbar and 

Title Bar. 2. The Ribbon with Tabs, 

Groups, and Commands. 

3. Name Box and Formula Bar. 

4. Worksheet area with Column 

Headers (the Alphabet) and Row 

Headers (the Numbers). The 

intersection of columns and rows 

create cells and the Excel grid. 

5. Navigation buttons and 

Worksheet tabs. 

6. Status Bar, View Buttons, and 

Scrolling Zoom. 

Wo rk sh ee t  Win do w 

 

The top area of your screen is the Quick Access Toolbar with the Title Bar. The File Tab which 

is the first tab in the Office Ribbon allows you to print, save, and perform other file  

functions; we’ll learn much more about this including using the Excel Options button. Next in 

this area of your worksheet is the Quick Access Toolbar which allows you to quickly access 

your favorite commands and you may add and delete commands from this toolbar.  We’ll learn 

how to customize the toolbar and other options for using this productive tool in Excel.  The Title 

Bar displays your Excel File or Workbook Name and contains the Help, Ribbon Display 

Options, Minimize, Restore/Maximize, and Close commands. 
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 As pictured above, the next area is The Ribbon. The Ribbon contains three areas – The Tabs, 

The Commands, and The Groups with the Dialogue Box launcher. We will use the Ribbon 

extensively in all aspects of Excel from formatting to creating 

formulas and functions.   

1. Let’s open a sample workbook to use in our 

demonstration. 

2. Click the File Tab. 

3. From the Menu, Click Open.  

4. Navigate to where your files are stored for this 

course. 

5. With the Budget.xlsx file selected, Click Open OR Double Click the 

Budget.xlsx icon to open the file in Excel. 

6. If you are prompted to Enable Macros, please click Enable Macros.  

Our workbook opens.  We should have two workbooks open a blank workbook and the 

Budget.xlsx workbook. 

 If you don’t have two workbooks open then follow these steps.  

1. Click the File Tab and Click New or use the Keyboard Shortcut CTRL + 

N (Pressing the Control key and the “N” keys simultaneously) for a new 

Workbook. 

2. From the New Workbook screen click the Blank Workbook item and 

then click the Create button at the lower right of your screen.   

We can “toggle” or move between the two files using our View Tab on the Ribbon and Clicking 

the Switch Windows command button. Let’s try this.  

Groups 

Tabs 

Command 
Buttons/Icons 
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1. Click the View Tab and click the Switch Window, 

2. Click the File that is not active, for example my 

Book1 as displayed here and the file activates.  

3. If your View tab is still active (or if not then click it 

to activate it again), and then click your Budget 

workbook to activate it. 

 

Below the Ribbon and Groups are the Name Box 

and the Formula Bar. The Name box indicates 

your position and selected cell in the worksheet 

and allows you to give selected cells an English name or code which we learn later in our course.  

This allows you to quickly move to this area of your worksheet and to calculate formulas using 

names.  

 

The Formula Bar illustrates the contents of your cell whether numeric or alpha text.  You edit 

your functions and formulas in this box.  Formula and functions begin with an equal sign (=), 

we’ll learn a lot more about this in the Formula and Functions part of our course. Cell A1 in 

this worksheet uses the =TODAY() function. 

A Hot Tip! Select All Button:  There is a magic box in 

the upper left part of your worksheet (bounded by the 

Column header A and Row header 1).  This magic box selects 

the entire worksheet with one click of this button; this is the 

Select All Button. If you are not clicked in the table of data, 

you may select the entire worksheet by pressing the CTRL + 

A keys together; if your cursor and selection is in the table of 

budget and expense figures CTRL + A keys selects the data 

table not the worksheet. This is a terrific way of selecting a 

table or database in Excel using CTRL + A key rather than 

selecting a big area of the worksheet through Click and Drag 

or other methods of selection that we will learn.  

 

Column Headers are the Alpha characters of the column.  You may click on a Column Header 

and the entire column selects or highlights.  You may click on a column header and drag to the 
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desired column to select multiple continuous columns.  You may select columns that are not 

continuous by left clicking, pressing the CTRL keyboard button, and then left clicking the 

desired columns; when complete release you CTRL key and mouse button and Viola your 

columns are selected.  You may use this method to select various cells and rows, as well, that are 

NOT continuous.  

 

 A Hot Tip!  In this document when we want to select cells 

and areas that are not contiguous I will use the term Ctrl + 

Click to indicate using the Ctrl key and click method of 

selection.  When we want to select areas that are contiguous 

I will use the term Shift + Click or we may also use Click and 

Drag to select continuous areas of our worksheets.   

 

Row Headers are the numeric characters or numbers of the row and operate in the same fashion 

as Column Headers. 

A Cell is the intersection of a column and row.  Cells are signified by the column letter and row 

number position, such as Cell C4 is the intersection of Column C and Row 4 or G10 is column 

G, Row 10 (BINGO! Ha, ha!)  You may select multiple cells by left clicking on a cell and 

dragging to the area that you desire and release your left click button. 

Let’s practice selecting continuous and non-continuous 

columns and hiding and unhiding them. 

1. With your Budget Workbook open and 

your January tab active, click column header 

C. 

2. Press your Shift Key and Click the 

column header G. Columns C through G 

highlight for you.  

 A Hot Tip: You may get the small dark arrow to select 

your column header and click and drag to select your 

continuous columns, too.   

3. With these columns selected, right click on one of the Column 

header’s letter and from the shortcut menu click Hide and the 

columns disappear. 
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Let’s unhide them and then hide columns that are not continuous. 

4. Click the Select All button at the top of your workspace area to select 

the entire workbook. 

5. Right click on a column header and from the menu click 

unhide. 

6. Now, click column header C and press the CTRL (or Control) 

Key and keep it pressed as you click other columns. 

7. With your CTRL key pressed, click column header F and column 

header H.  These columns select for you as you click them with 

the CTRL key pressed. 

8. Now, right click one of your selected column headers and from 

the short cut menu choose hide. 

9. These non-continuous columns hide for you. 

10. Let’s unhide them. Click the Select All button at the top of your 

workspace area to select the entire workbook. Right click on a 

column header and from the menu click unhide. 

Notes: 

  If you want to unhide a specific column but keep the others hidden for 

example, if I want to unhide Column C but keep the other columns hidden, I 

can select Columns B through D with Column C hidden and right click on the 

two selected column headers and from the shortcut menu choose unhide 

and only Column C is unhidden. 

 If you click inside of the Budget and Expenses and press CTRL + A only 

the table of data selects not the entire worksheet.  You may use the Select 

All button to select the entire worksheet or CTRL + A to only select a table 

or database in Excel. 

Worksheet area is the area surrounded by the column and row headers and is 

your primary work space in a worksheet. 

Worksheet Navigation Buttons and Worksheet Tabs: The Navigation 

Buttons at the lower left of your workspace area scroll to various worksheets 

within your workbook in order for you to select the worksheet in which you 
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desire to work.  A description from left to right by clicking the appropriate button is:  

Button 1: The small left arrow scrolls through the worksheets to the left. Notice the shortcut 

menu if you hover on the left arrow as displayed here. CTRL + Left clicking 

this arrow will display the first worksheet. Right clicking this area displays 

all sheets as described in the Hot Tip below.  

Button 2: The small right arrow scrolls through the worksheets to the right 

and CTRL + Left clicking this arrow will display the last worksheet for you.   

 

A Hot Tip!  If you have multiple worksheets 

as the Budget file does, you can quickly go to 

a specific sheet by right clicking on the 

navigation buttons to get a shortcut menu 

and then left clicking the sheet you desire.  

In the picture at right my January sheet is 

active and all of the sheets are displayed.  If 

I wanted to go to the October sheet, I could 

click it and that sheet would activate.  

Worksheet tabs names your worksheet and 

become active upon clicking on the tab.     

 

The Status Bar displays information about your worksheet and 

cells, displays whether your Number Lock and Caps Locks are 

activate, whether you are recording a macro, and has a nifty Calculation box that we will use 

later. 

You can navigate in your worksheets and through your worksheets with several keyboard 

shortcuts, too, and select data in a column or row quickly.   
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My Favor i t e  Exce l  S ho r t cu t s  

Keyboard Shortcut What it Does 

CTRL + Home Takes you to the top of your worksheet, 

usually cell A1. 

CTRL + End Take you to the end of your worksheet. 

PgUp (Page Up) and PgDn (Page 

Down) 

Takes you down or up several rows 

(screen pages) at each press of the key. 

CTRL + PgUp (Page Up) and 

CTRL+PgDn (Page Down) 

Scrolls through your worksheets or tabs.  

CTRL+PgUp Scrolls to the Left for you and 

CTRL+PgDn scrolls to the Right. 

CTRL + Shift + Down/Up Arrow Selects an entire column of 

data/information based on the cell that is 

selected. 

CTL + Shift + Left/Right Arrow Selects an entire row of data/information 

based on the cell that is selected. 

CTL + Shift + Home Selects from your active/selected cell to 

the top of your worksheet.  

CTL + Shift + End Selects from your active/selected cell to 

the bottom of your worksheet. 

 

With your Budget file open, use these navigation techniques to navigate 

around your worksheets and open the Track workbook and select a column 

and row data using the CTRL + Shift and arrow keys. You may use the Shift 

key and arrow keys to select individual row or columns and with the Shift key 

pressed, press the Page Up (PgUp) or Page Down (PgDn) to select a larger 

area of your worksheet. 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 
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Imp or tan t  T ip s  to  mak e  yo u r  Exce l  

Exp er i en ce  Eas i e r  

Resizing columns and rows 

If you position your cursor between a column and row header, a double-headed arrow will 

appear as your cursor.  Click and drag to resize your column or row.  You should place your 

cursor to the right of the column you want expanded and below the row you want increased.  For 

example, to change the width of column C move your cursor between column headers C and D 

to get the double headed arrow to resize your width.  To change the 

height of row 7 you would move your cursor between row 7 and 8 to 

get the double headed arrow to change the height of row 7.  You may 

right click on a column or row header and from the Shortcut menu 

choose Column Width or Row Height and the screen here appears for 

you to type in a number for the width/height of your column/row. 

 A Hot Tip! If you double click your double headed arrow 

cursor, the row or column will automatically adjust to fit the 

information in the column or row.  Pound symbols or hash tag 

marks (#######) will appear in column cells that are not 

large enough for you to view the data.  The pound symbols or 

hash tag marks in a cell have “freaked out” many a new user 

to Excel, including me.  I felt like I had done something 

terribly wrong.  Simply resize your column width so the data 

in the column will fit.  

Rename a Worksheet 

To rename a worksheet, double click the worksheet tab at the bottom of the screen.  For 

example, to rename Sheet 1 double click the Sheet 1 tab, the tab is highlighted, and type a new 

name and press enter.  Also, you may right click on the Sheet Tab for a short cut menu to 

Rename the worksheet.  As well as Renaming your worksheet, Right clicking on the tab allows 

you to insert, delete, or move/copy your worksheet.  This is a great tool and short cut that we 

will be using throughout this course.  
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 Notes: Worksheet names should not contain special characters, such as /, 

?, or [] and you may not use the same name twice in a workbook.  You are 

limited to 31 characters for a name.   

 

A Hot  T ip !  Status Bar and 
Calculations 

The Status Bar in Excel has many options from which to 

choose.  I like having the Sum, Count, Average, and other 

functions on my Status bar.  You may right click on your 

status bar and receive the Customize Status Bar Pane as 

pictured at right.  I have activated all of my options as I learn 

Excel. 

This doesn’t affect your worksheet, but does provide the 

result of the functions based upon your selected range of 

cells.  This is another excellent and quick tool for 

summarizing, averaging, etc. cells and information that are 

continuous or not.  Let’s try it out 

1. In the January Tab of your Budget 

worksheet, Click and Drag cells B5 

through B14 to select them. 

2. The Sum, Average, Count and other 

functions of the cells should appear 

based on your selection in the Customize 

Status Bar pane.  

A Hot Tip!  Another neat trick is to use the CTRL + Click method to select 

cells that are not continuous, such as B5, B7, B9, the Calculations will provide 

the SUM ( or other selected function) for the cells selected. This provides 

quick calculations for cells that are not continuous and prevents you from 

creating a formula or pulling out the good-old calculator.  
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Vertical and 
Horizontal 
Scrolling 

Bars 

1. Let’s select non-contiguous cells and see the results. 

2. Click Cell B5. 

3. Press your CTRL key and keep it pressed as you click the following 

cells:  C7, C8, C10, C11, and B16. 

4. Notice that as you click your cells your calculations change.   

5. You can click away from the area to deselect your changes. 

 An Important Gotcha! If you accidentally click the wrong cell or do not want a 

previously selected cell in the calculation, you cannot CTRL + Click the cell again to 

deselect it as you can in other applications and areas of Excel.  You’ll have to start 

from the beginning of selecting your cells using the CTRL + Click method again.   

 

There are important items at the end of your Status bar.  The View command buttons for 

Normal, Page Layout, and Page Break Preview are here for you and the Scrolling Zoom. 

We’ll look at these views 

later. 

Click the Zoom selector 

arrow and click and drag in out to see how Excel changes your view of your 

worksheet.  

 A keyboard shortcut is to press your Control (CTRL) key 

and use your mouse’s wheel (if you have one) to zoom in or 

out depending on the direction you are rolling your 

mouse wheel.  

 

Go To and Scrolling Bars  

Use your vertical and horizontal scroll bars to quickly move through your 

worksheet area.  You may move to a Specific Cell by pressing your CTRL key 

and G key at the same time or pressing the F5 key on  your keyboard and the 

Go To dialogue box appears.  Type the Cell you wish to go to in the reference 

section. 

Let’s practice this. 

1. Press CTRL and the G key simultaneously OR press 
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the F5 Button on your key board. 

2. Type B20 in the reference section, 

3. Click OK or press Enter. 

4. You are quickly in Cell B20.   

 

A Little Review Here: Shift Clicking and CTRL Clicking:  As explained in the Column Header 

section, if you desire to select continuous rows, columns, cells, and even worksheets click on an 

item, press shift, and click the last (Shift + Click) item you desire to be selected.  (The columns, 

cells, or rows are selected continuously.)  If you desire to select items that are not continuous, 

use the CTRL key to click your desired row headers, cells, column headers (etc.) and your item 

will be selected until you release the CTRL key and cease clicking (Ctrl + Click). 

 

Note the ScreenTip as you position your cursor over a command button or area of your 

worksheet.  This is very helpful to understand the purpose of the command button or area. 

 

 A Hot Tip! The ESC (Escape) key: Another handy key on 

your keyboard is the Esc (or the Escape) key.   When doubt, 

press this a couple of times to clear your formula, selected 

cells, and other times when you feel you are making a mess 

or Excel won’t let you move or navigate because you have not 

completed a function.  The Escape key will help alleviate 

trouble, but may not prevent bad formulas and formatting.   
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Customizing Excel  for Productivity  
 

Q u ick  Acces s  Too lba r  Op t ion s  and  

Cu s tomiza t io n   

As we begin using Excel, we need to learn the Quick Access Toolbar and how to add command 

buttons to it.  We’ll examine the Ribbon and other new interface techniques as well as using old 

(even ancient) keyboard commands that have been around since DOS and new keyboard 

commands called Key Tips that were new to Office 2007/2010. Adding your own command 

buttons to the Quick Access Toolbar ensures the command button is always available for you 

since your command buttons change based on which Tab you have active.  

New with Office 2010 and continues with Office 2013/2016 is the ability to customize the 

Ribbon and create your own tab as well as to enable and disable tabs.  We will accomplish this 

in your next section. 

 

 Important Gotcha! When your Excel Options menu is open and active nothing in 

Excel is operable and all tabs and groups are disabled.   

 

Let’s look at the Customize Options for our Quick Access Toolbar.  

1. The Quick Access Toolbar is the 

only toolbar in Office and is located at the 

top area of your screen in the Title Bar area.  

2. In a blank Worksheet or the 

Budget workbook, click the Arrow at the end 

of your Quick Access Toolbar to list the 

Customize Quick Access Toolbar command 

buttons and options. 

3. You may quickly add command 

buttons to your toolbar by clicking them in 

this window to add them to your toolbar – 

the check mark represents a command 

button already on your toolbar. 
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4. The cascading menu closes after you check an item to add, such as 

New, Open. I wish the menu could remain open as you check these 

command buttons.  Check all of the buttons to add these to your 

Quick Access Toolbar. 

After adding these buttons, we will further customize the Quick Access Toolbar with some of 

my favorite and popular commands in Excel.  We will use the More Commands from your 

Customize Quick Access Toolbar Pane.  

We are using the More Commands button and Excel option screen for three reasons: 

1. You may rearrange and move your buttons as you like, 

2. You may add more than one button at a time, 

3. You may add buttons that do not exist in the Ribbon or Tabs. 

Let’s rearrange our buttons and add some neat and helpful commands, so we may quickly use 

some of Excel best commands. 

 

1. At the end of your Quick Access Toolbar click the arrow and then click 

the More Commands. . . item in this menu. 

2. The Excel Options Pane opens at the Customize screen ready for you 

to select commands and add them to your toolbar. First, let’s move 

some of the commands we have already added.  

 

Write your notes here:_________________________________________________________ 
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3. Click the New command button and using the Up arrow click to move 

the command button to the top as displayed above. Next move the 

Open and the Open Recent File… below the New button. Rearrange 

your buttons to fit your needs. 

Now, let’s add buttons to our Quick Access Toolbar. You may add buttons 

by selecting the command you want on the left part of the pane and double 

clicking the button or clicking the Add button in the center of the Pane.   

 Hot Tip! You may add your button to your Quick Access 
toolbar in the position you want by selecting the Quick Access 
Command, such as Sort Descending and the double clicking 
or clicking the Add button and the Custom Sort button is 
beneath your Sort Ascending and Descending buttons. Excel 
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places the new command button below where your selection 
is on the right part of your pane.   

1. I have added some of my favorite command buttons from the Popular 

Commands section.  As you use Excel, you will find command buttons 

that you will want always available for you. Using the Popular 

Commands item in the Choose commands from: box, here are some of 

my favorite commands to add to and rearrange on my Quick Access 

Toolbar using the Popular commands item: 

✓ Save as, 

✓ Custom Sort, 

✓ Cut, 
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✓ Copy, 

✓ Paste 

✓ Paste Special 

✓ Insert Sheet Rows 

✓ Insert Sheet Columns 

✓ Set Print Area 

✓ Freeze Panes 

✓ Page Setup 

✓ Paste Special  

✓ Insert PivotTable 

Add your popular commands and rearrange them on the Quick Access 

toolbar by selecting a command and using the Up and Down arrows to 

move your buttons. 

 

The Drop-down box (circled below) at the top of the customize screen allows you to choose 

other Tabs or All Commands in order to add other command buttons to your toolbar; this is 

the Choose commands from box.  The 

second box at the right allows you to use 

the custom Quick Access Toolbar in all 

workbooks or only the current 

workbook. We want this for all of our 

workbooks. 

1. Next change your Choose 

commands from box to All 

Commands as circled here. Click 

in your list of commands to select 

a command and press the letter 

A and scroll to AutoFilter.  

Pressing the letter on the 

keyboard and keeping the letter 

pressed, Excel will scroll through 

all of the commands associated with the first letter. Add AutoFilter to 

your Quick Access Toolbar this command button doesn’t appear on the 

Ribbon and is very helpful.  This one button accomplishes two tasks – 
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first, it will filter for whatever you have selected, and second, it will 

turn on your filtering for you.  I also add the Clear Filter button.  Notice 

ALL of the Commands in Excel and add your buttons as you wish.  

2. Next, click back in the All Commands list and press the letter C on your 

keyboard. Excel jumps to the C for you to scroll down or continue 

pressing the letter C on your keyboard to find the Clear All Filters 

button. You want the Clear button with the Funnel or Filter. 

3. Next, decide if you want to show the Quick Access Toolbar above or 

below the Ribbon. Since I use so many commands on my Quick Access 

Toolbar which crowds my Title bar, I like having my Quick Access 

Toolbar below the Ribbon so I have checked the box. 

4. Click OK. 

 

 Speak! Another button I add in Excel is Speak Cells. This is 

a cool feature to have your computer and Excel read your 

selected cells. You’ll like this for two reasons: 

 1. It does not turn itself on; you’ll select the area you want 

Excel to read out loud and then click this button.  

2. It only reads what you have selected (columns, rows, and 

cells).  

I used this as a Compensation Manager to read Social 

Security Numbers and salaries; I was the only person that 

could know this confidential information. I had to be perfect 

in my salary treatment using Excel; having Excel speak the 

numbers ensured perfection (not easy for me to be perfect!). 
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You may stop speak by clicking the button again or pressing 

the ESC key. This works in the other Office applications, too. 

So, enjoy having your computer talk to you with Excel data. 
 

 

Make a mess – here is how to reset your Quick Access Toolbar. 

 

A Hot Tip!  The Reset button will restore your Quick Access 

Toolbar back to the Factory Standard 

with no customization.  Pressing the 

Reset buttons offers you to Reset only 

the Quick Acces Toolbar or All 

Customizations.  The Dialogue box 

below appears when you click the Reset button.  I sure do 

not want to click yes, since we will use our Quick Access 

Toolbar throughout the course.   
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There is a quicker and easier way to add buttons to your Quick Access Toolbar and here’s the 

HOT TIP for you. 

 

 A Hot Tip:  You may add any command button to the Quick 

Access Toolbar by right clicking the command button and 

from the menu choose add to Quick 

Access Toolbar.  I have right clicked the 

Arrow under the AutoSum button in the 

Formulas Tab and the menu displays for 

me to click the Add to Quick Access 

Toolbar item and Excel places the 

command button on the toolbar for me.  

Using this method places the button at 

the end of your toolbar, unfortunately 

you must use the Customize Quick 

Access Toolbar pane in Excel Options to 

rearrange the commands position, as 

we accomplished earlier.  I like have my 

Sum, Average, and Count functions quickly available for me 

without using the Home or Formulas Tabs. 

 

 Write your notes here:_________________________________________________________ 

 

  



Page 28 Excelling at Excel: The FUNdamentals Level 1  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2017 
No Duplication Permitted  404-403-5391 

Tab s  a nd  Th e  R ibb on  S ho r t cu t s  

As we begin our study of the tabs and groups, here are a couple of important and time saving 

Hot Tips for you in using the Ribbon and Tabs! 

 Hot Tip 1:  Minimize the Ribbon! Four ways to minimize the Ribbon – First, the 

Ribbon takes up a lot of space on your screen. You may minimize the Ribbon and 

use it only when you click on a Tab.  

1. Office 2013/2016 has the Collapse (Office 2007 and 2010 
uses the term Minimize) Ribbon arrow at the top of your 
window next to the Help button.  The Collapse the Ribbon 
button appears here. With the Ribbon minimized the button 
becomes the Expand the Ribbon button in 2013 or a push pin 
in 2016. 

2. To collapse/minimize the ribbon double click the active 

Tab’s Name. Double clicking a tab expands/collapses the 

ribbon, too, or as the short cut menu suggests use the Keyboard shortcut of F1 

described next. 

3. Keyboard shortcut of CTRL + F1 – when you press your CTRL (Control) and the 

F1 keys simultaneously on your keyboard the Office application minimizes and 

expands your Ribbon, too. 

4. Right click on any tab or command 

button on the Ribbon and from the 

short cut menu choose Collapse the 

Ribbon at the bottom of the menu.  

Why minimize The Ribbon?  The Ribbon takes 

a lot of space. With the Ribbon minimized you 

have more room in which to work on your file.  With the Ribbon minimized, to use a tab, you click the 

tab and the Ribbon’s tab expands for you to use the Command Buttons.  After clicking the button you 

want and you click back into the body of your document, worksheet, or presentation the Ribbon 

minimizes again. This is similar to using the old Menu bar.  The difference is the Menu bar was 

vertical and text oriented and the Ribbon is horizontal and more graphically oriented.  
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 Hot Tip 2: Second, if you have a scroll wheel/button on your mouse and 

the Ribbon is NOT minimized, you may scroll through the different tabs 

rather than clicking the tab.  Moving your cursor to the  Ribbon and rolling 

your scrolling button/wheel up or down changes the tabs for you! You must 

first click on a tab for this to work; otherwise, the application will scroll 

through your file – not the Ribbon.   

 An Important Gotcha! With the Ribbon minimized you cannot scroll through the 

Tabs as described above.  You’ll have to maximize the ribbon in order to scroll 

through your tabs and command items.  

Try these two shortcuts, I think you’ll like using these two features in Office. 

Excel’s interface includes the Ribbon which contains tabs as we have studied and within the tabs 

there are groups such as the Clipboard group, Font Group, and Alignment Group as displayed 

here.  At the bottom of some groups you will notice an arrow, as circled 

above, this arrow is the Dialogue Box Launcher which offers more 

options for you.  Activating a Dialogue box from this group opens the 

Dialogue box tab for that group.  When I clicked the Font Dialogue box 

launcher, the Format Cells Dialogue box opens at the Font Tab. 

We will use many of these tabs, groups, panes, and dialogue boxes 

throughout this book.  We’ll start with the Home Tab and Formatting 

options, including the Mini Toolbar, after we look at some of the 

Keyboard shortcuts and Key Tips. 

 

 Hot Tip! You may add a Dialogue box to your 

Quick Access Toolbar by right clicking the 

Dialogue Launcher Arrow and from the menu 

choosing Add to Quick Access toolbar just as we 
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accomplished with the AutoSum button.  As displayed here I 

am adding my Font  format cells dialogue box to my Quick 

Access Toolbar.   

 

 

 Write your notes here:_________________________________________________________ 
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Keyboa rd  Sh or t cu t s  a nd  Key  T ips  

Here’s a nifty table of my favorite Office, including Excel, shortcut keys. 

My Favorite Keyboard Shortcuts 

Keyboard 

shortcut 

Command Keyboard 

shortcut 

Command 

CTRL + A Selects a Table when clicked in the table or 

Selects All if not in a data table. 

CTRL + T Excel Create Table 

CTRL + B Bold CTRL + U Underline 

CTRL + C Copy CTRL + V Paste  

CTRL + D Excel – Fill Down – Duplicate 

PowerPoint – Duplicate 

Word – Font Dialogue Box 

Outlook - Delete 

CTRL + W Close – Closes the Workbook in Excel,  

CTRL + E Word and PowerPoint Center Alignment – 

Paragraph 

Excel – Flash Fill (2013/2016) 

CTRL + X Cut 

CTRL  +  F Find CTRL + Y Repeat Last Action 

CTRL  + G Go To CTRL + Z Undo 

CTRL + H Replace ESC This key cancels the current command or 

operation. 

CTRL + I Italic CTRL + Home Top 

CTRL + J Word and PowerPoint Justify Alignment – 

Paragraph 

Excel- Unassigned/Doesn’t work 

CTRL + End End/Bottom 

CTRL + K Insert Hyperlink F1 Help 

CTRL + L Word and PowerPoint Left Alignment – 

Paragraph 

Excel-Creates a Table 

F5 Go To 

CTRL + N New F7 Spell Check 

CTRL + O Open F10 Key Tips 

CTRL + P Print F12 Save As 

CTRL + Q Quick Analysis Toolbar (Click in data table) CTRL  + Mouse 

Wheel 

Using a scrolling wheel on your mouse, you may 

press your CTRL (Control Key) and with it pressed, 

roll your scrolling wheel up to increase the size of 

your document, worksheet, etc. and roll the 

wheel down to decrease the size. This is the 

keyboard shortcut for the zoom feature. 

CTRL + R Right Align 

CTRL + S Save 
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There are other keyboard shortcuts, too.  You can use the help system in Excel for a list of all 

keyboard shortcuts that perform a variety of operations for you, just type Keyboard Shortcuts in 

the Help Search Box (“Tell me what you want to do” box in Excel 2016) 

Now, in the Office Suite 

are keyboard shortcuts 

called Key Tips.  To 

activate your Key Tips, 

press the ALT or F10 key 

on your keyboard.  Excel displays screen tips or Microsoft calls these badges pictured here.  To 

activate a Tab press the corresponding badge key, for example press H to activate the Home Tab 

and the badges for this tab’s commands.  

Let’s try this in Excel. 

1. Open Budget workbook. 

2. Press your Alt key to activate your Key Tips or you may press the 

Function 10 (F10) key on your keyboard to display the Key Tips.  

3. Press your 

P key on your 

keyboard.  Notice 

that Excel 

activates the 

Page Layout tab 

and Key Tips on all of your commands on the Page Layout Tab appear. 

4. Press the O key to activate your Portrait or Landscape Orientation. 

5. Press the 

Down Arrow key 

on your keyboard 

to Select 

Landscape and 

press enter to activate the selection. Your worksheet is now 

Landscape. 
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6. Let’s return this to Portrait by pressing your ALT or F10 key, Pressing P 

for Page Layout, Press O for Orientation, and since Portrait is selected, 

press enter and the worksheet returns to Portrait Orientation for you. 

 

Why Key Tips? Many people still do not like using the mouse (YET) and prefer only using the 

keyboard; using key tips you never have to use the mouse for commands in the Ribbon or 

Quick Access Toolbar.  Also, this aids people with Carpal Tunnel Syndrome.  

 Write your notes here:_________________________________________________________ 
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The Functions Keys and combination keys such as Shift and a Function key are still around, 

too.   Here are some of the Function Keys from Excel.  

Function 
Key 

Command 

F1 Excel Help. 

F2 Edits the active cell and positions the cursor/insertion point at the end of the cell’s 

contents. 

F3 Paste Name Dialogue box appears 

F4 Repeats the last command or action. Also, if you click in your formula bar at a cell, the 

F4 key will toggle through your various references that we will learn, such as relative 

or absolute. 

F5 Go To Dialogue box activates. 

F6 Switches between the worksheet, ribbon, panes, and other areas of your worksheet. 

F7 Activates Spell Check. 

F8 Extend your selection (or increases your highlighted areas.) Press the F8 key and then 

use your arrow keys or other keys to select cells, rows, and/or columns for you. 

F9 Calculates all open worksheets. 

F10 Show Key Tips. 

F11 Creates a chart from the selected range. 

F12 Activates Save As Dialogue box. 

Activate the Help box by pressing the F1 key on your keyboard.  Type in Function keys or 

keyboard shortcuts and Excel will list a lot of shortcuts for you.  I encourage you to review these 
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and find your favorite shortcuts as you use Excel. We will use many of these shortcuts and items 

throughout our course. 

File Management 

The File Tab, Backstage View, contains many important features in managing your Excel 

workbooks and properties. Let’s overview the functionality of File that you will use a lot in 

Excel. 

 

1. With an Excel File open, Click the File tab and click the Info item. 

2. My Information pane appears here with the ability to set permissions, 

share, and to use important document 

properties.  Notice that the left part of 

the pane contains our favorite 

commands of Save, Save As, Open, 

Close, and Print. Here are some of the 

items we will learn throughout our 

course in using the expanded, more 

powerful, and simpler File tab. 

 

✓ Open – For recent and pinned files, 

✓ Print – One Stop Shopping – Print, 

Print Preview, and Page Set-up, 

✓ Save, Save As, and Export  – Saving in popular (PDF) and email at one place, 

✓ Options – Setting Important Options throughout Excel. 

 

Microsoft calls the File area the Backstage view, since none of your other 

tabs and buttons work and are not visible in 2013/2016. You may return to 

your normal view by clicking the arrow at the top of the File menu. We’ll 

examine each of these items as we move through the course.  
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Op en  a nd  Recen t  F i l e s  

When you click the File Tab, Excel should open at the Info Pane. The Info, New, Open, Print, 

and other items appear for you. My Info Pane and File tab appear above and my Open appears 

below. The Open pane is organized in three sections: Your Common Tasks and Commands in 

the left section, Recent, Browse, and File Locations in the middle section, and then Pinned 

Files and your recently opened files grouped by date to the left.  The Common Tasks and 

Commands are consistent in the Office Suite.  

1. Click the Open 

item on your 

File Tab (or 

use the button 

on your Quick 

Access Toolbar 

that we added 

earlier).  I use 

my Recent 

pane and 

pinned 

documents for 

workbooks that I use frequently.  

 

 A Hot Tip! Pinning document, workbooks, presentations, 

etc.  The Office Suite, except Outlook, 

helps you quickly open your favorite 

and often-used files. You pin your 

favorite files by clicking the push pin 

button at the right of the document 

in the Open pane.  This pins the file 

at the top of the pane. You may 

unpin and remove from the list by 

right clicking on the file and the 

shortcut menu as displayed appears 

for you to perform popular options, 

including Opening, Pinning/Unpinning, and Removing from 
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List.  You should pin your Recent Files as you begin opening 

and using your files in Office 2013/2016.   

We examine Print, Options and these other areas of the Backstage View throughout our course.  

Now, that we are familiar with the interface, shortcuts, and other Excel items, let’s start 

Excelling at Excel with the 5 F’s of Excel. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 
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The Five F’s of Excel  

We begin our journey learning Excel through the 5 F’s.  Here are the Five F’s that we will learn 

in detail during this section and we will re-enforce our knowledge and build upon the 5 F’s 

throughout our time together. 

 

F1:  Formatting 

F2:  Fills 

F3:  Formulas 

F4:  Functions 

F5:  Filters and Sorts 
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F1 :   Format t in g  fo r  App ea ra n ces  Sak e  

Now, let’s look at the 5 Fs of Excel.  The First F is Formatting.  Let’s have fun with formatting 

our cells and worksheets.  Primarily you will use the Formatting Groups on the Home Tab or 

the Format Cells Dialogue box.  

A Hot Tip! You may activate the Format Cells dialogue box 

by pressing your CTRL key and the number 1 key at the top of 

your keyboard (not the 1 key on your key pad) 

simultaneously.  Also, you can right click on your selected 

cells and from the shortcut menu choose Format Cells. If you 

added the Format Cells button to your Quick Access  

Toolbar, you use that too.  

 

We will learn in detail all of these command buttons on the Home Tab. We will use all of the 

tabs on the Format Cells dialogue box, too.  Before we format, we need to enter data into our 

blank worksheet.   

1. Open Excel, if you are not in Excel. 

2. You should be at a blank new workbook.  If not, click the New Icon, if 

you added it to your Quick Access Toolbar or Press the CTRL key + N 

key simultaneously.  This creates a new workbook file for you.  Excel 

will display Book2 (or another number) on the title bar for you. 

3. Click in Cell A2 and type:  January Budget and Expenses.   

To enter numeric data or alpha data simply begin typing in a cell.  As you type your input 

appears on the Formula Bar and in the Cell in which you are typing.  Since there is no data in 

cell B2, our text will display; otherwise, our text would be truncated in Cell A2. 

To Move from Cell to Cell you may Click, Tab, or press Enter.  Depending upon your options 

pressing Tab takes you to the right one cell or Enter may take you down. To Edit previously 

Input data, Use the Formula Bar to highlight and select the data you want to change and type 

over the information or type in the cell.  
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 A Re-enforcement Note that your Name Box displays the cell in which you are working and 

the Formula Box displays the contents of the cell.  Move to different cells using your return 

key, tab key, arrow keys, or mouse button.  It is important to input the information first – 

accomplish your formatting once some of your input is complete.   

1. Input as follows or enter your professional budget and expense data 

in the cells. 

 

 

 

 

 

 

 

2. Save your Workbook as My 

Budget.xlsx  (Click the Save Icon or 

use File, Save to Save your file.) 

3. Continue inputting the information 

as pictured here. 

4. In Cell A14, Type Total.  We will use 

a function later for Excel to Total 

the information. 

5. In Cell A15, Type Average.  We will 

use a function later for Excel to 

Average our information. 

 A Hot Tip! Entering data in Excel 

by Selecting and Using the Tab Key.   

If you Select the areas of A5 through 

C15 and using the Tab Key to move from cell to cell, Excel will 

highlight this area and remain in this area for input and will 

not move to column D or row 21, until the selected range is 

cleared or press an arrow key.  You can press the Shift key 

and the Tab Key together to go backwards. You may press 

the Enter key to go down and the Shift and Enter Key 

together to go up.  Simply select the area for input, type your 

Cell Data/Text 

A4 Item 

B4 Budget 

C4 Expenses 

D4 Difference 
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information in a cell, press the tab key, and Excel will move 

to the next cell to the right.  This assists in data input 

accuracy.  However, you may not use the arrow keys or 

delete key; these will deselect your area or delete everything!  

You may use the Backspace key to remove characters and 

make corrections.   

Formatting Groups 

Once data is in our cells and worksheet, we are ready to format.  We will format our selected 

rows, columns, and cells in several ways: 

✓ Formatting command buttons on the Home Tab and Font, 

Alignment, Number, and Styles Groups,  

✓ The Format Cells Dialogue Box, 

✓ Use our Quick Access Toolbar or Custom Tab, 

✓ The Mini Toolbar. 

 

 A Hot Tip: The Mini Toolbar.  When you 

right click selected cells, rows, or columns, 

Excel provides a Mini Toolbar containing 

many popular commands, including 

formatting commands, such as font, font 

size, dollars, bold, colors, and so on.  We 

will use this a lot in this course.  Excel 

provides a short cut menu when you right 

click, too. You may activate the Format Cells 

Dialogue Box from this menu and perform 

many other helpful actions.   

The Merge and Center  

Okay, let’ have fun with formatting; we first want to have our title January Budget and 

Expenses centered across our worksheet area. In using Excel, the text and information for a cell 

will display unless there is text and data in the adjacent cell, then your data is truncated or cut-

off.  The text and data are still there just not visible except on the Formula Bar. You have three 

choices: 
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✓ To make the column wider so your information will fit, 

✓ To use Wrap text in the cell (which we will learn later), 

✓ To use the Merge and Center button. 

In most cases make the column wider is acceptable; however, your column heading may be too 

wide for the data in the rest of the column.  A Hot Tip! For 

Headings and Titles You will want to use the Merge and Center 

Command Button.  The Merge and Center command button will 

collapse your selected cells into one cell and center the information in 

this one cell. 

1. Using the Click and Drag method of selection, 

Select the cells A2 through D2. 

2. Once selected, Click the Merge and Center 

command button or use your Mini Toolbar. 

Our A2 cell is now one, big cell encompassing the former cells of B2 through D2.  Click Cell D2, 

notice the Name Box displays A2.  The Merge and Center Command button: This button is 

primarily used for titles that extend beyond one cell. 

 As a review, select the cells you want merged and click this button to transform multiple 

cells into one cell and center the information contained in the cell. 

 An Important Gotcha!  If you try to sort your data do NOT include this cell.  Excel 

will give you an error message as displayed at right. 

To remove Merge and Center from a Cell, Select the 

cell and click the Merge and Center command button, 

again. Or you may remove Merge and Center by using 

the Format Cells Dialogue Box and the Alignment 

Tab.  At the Dialogue box click the Alignment tab 

and notice the check mark in the Merge cells box, uncheck (click the check mark) box 

in Merge cells.   

Merged and Merged and Centered commands are only for titles and headings not for 

the data in tables. Table and databases do not have merged cells.  
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Font Group 

With Cell A2 the Merge and Centered cell selected and using the 

Font Group’s command buttons please make the following changes: 

1. Change the Font to Arial using the font drop-

down list,  

2. Change the size to 14 using the list,  

3. Click the Bold Icon, 

4. Click the Italic Icon, 

5. Click the Underline Icon, 

6. Change the Fill Color to a dark color – I’m choosing a Dark Blue,  

7. Change the Font Color to a light color, using the Drop-down Arrow 

Color by the Font Color Icon. 

Our changes take effect immediately. 

Click the Save icon or use your keyboard shortcut by Pressing the CTRL + S 

keys. 

Format Cells  Dialogue Box :  Font 

While the Formatting Command buttons and Mini Toolbar 

offers quick and easy formatting options for us.  We will want 

to use the Format Cells Dialogue box for more options and 

formatting, particularly for different number styles, dates, and 

special font/character positioning. The Format Cells Dialogue 

Box Font Tab pictured here displays when we click the Font 

Group’s Dialogue Box Launcher.  We will be using this 

dialogue box throughout our course including the Protection 

tab when we examine security and protection later.   

The Format Cells dialogue box activates through these ways: 

✓ Right clicking in the selected cells and from the 

shortcut menu selecting Format Cells,  

✓ Pressing the Shortcut key of CTRL + 1 (The Control Key and the number 1 key 

together), 
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✓ Use the General Drop-down List in the Number Group and the last item is More 

Number Formats. . .  

✓ Use the Dialogue Box Launcher on the Font Group in the Home Tab. 

Alignment Dialogue Box and Group  

Let’s practice using the Formatting Dialogue box and some neat tricks for formatting our 

Headings. 

1. Click and Drag to Select the Cells A4, B4, C4, and D4 with the text 

Item, Budget, Expense, and Difference 

2. Activate your Formatting Dialogue box by Right Click in the Selected 

cells and click Format Cells from the short cut menu. 

3. With your Formatting Dialogue box displayed, Click the Font tab and 

select a different font, change your font size, and change your font 

color, 

4. Click the Alignment Tab.  Notice these important items: 

✓ Horizontal and Vertical Alignments for text in 

cells, 

✓ Text Control for Text Wrapping and Shrinking 

which we will use later, 

✓ The Merge Cells (we used the button for Merge 

Cells but we could have used this selection  with 

center Alignment), 

✓ The Orientation section which allows you to 

make your text vertical and angled. 

5. Click the Diamond for the 45 degrees 

or use the Spinner Control to select 45 

degrees. 

6. Click OK  

Wow!  Look at your angled text.  
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  A Hot Tip! Orientation Command Button.  

While the Alignment Tab in the Format Cells 

Dialogue box contains many options, the 

quickest and easiest way to angle your text 

is through the Orientation Command Button 

in the Alignment Group of your Home Tab.  

As pictured here, this button allows you to 

use several popular angling and rotation 

options.  At the bottom of the menu, the 

Format Cell Alignment opens the Format Cells Dialogue Box 

at the Alignment Tab.  

 An Important Gotcha!  While angled text looks great here, angled text doesn’t look 

good with shading and with borders – the colors and borders extend beyond your cells 

and you may not like it.  When we learn Borders and Shading, try it and see if you 

like it.  

 

Number: Format Cells 

Dialogue Box and Group 

Time to Format the Numbers,  

1. Click and Drag to Select cells B5 

through D15 OR Click Cell B5, press 

the shift key and keep it pressed, and 

click cell D15 to select this area.  

2. Let’s use the Format Dialogue 

Box for numbers. 

3. With the Format 

Cells Dialogue Box open, 

Click the Numbers Tab. 

4. Click the Currency 

Category and then select 

the Negative Numbers to 
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be in red and parentheses. 

5. Click OK. 

Our numbers format as Currency. 

 We will use the Number Group on the Home Tab and the Mini Toolbar for our Number 

formatting, too.  

Reselect the cells B5 through D15 in the Budget Workbook and 

Click the General drop-down list on the Home Tab and choose 

another format, such as Accounting for your numbers.  The 

menu for the General box and number formats is pictured here. 

 

 

 

 

 

 

 

 

 

 

 Write your notes here:_________________________________________________________ 
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Imp or tan t  T ip s  to  mak e  yo u r  Forma t t ing  

Exp er i en ce  Eas i e r  

Here are some other important and productive tips and tricks in helping with formatting and 

creatively using Excel. 

Themes 

Themes across the Office Suite help with consistency and offer a variety of ways of changing 

your workbooks, documents, and presentations.  The default Theme that Excel (and the Office 

Suite) uses is aptly entitled Office.  Themes will change your fonts, chart, colors, fills, shadings, 

and other items in your workbook. 

1. Open your Budget.xlsx file, 

2. Click the Page Layout Tab, 

3. Click the Themes button at the beginning of the 

Tab. 

4. Scroll through the gallery and look at various 

themes. As you move your cursor over a theme, Excel 

displays your worksheet in that theme offering you a 

Live Preview. 

5. Select a Theme for your workbook 

and notice you can create and save your 

own theme. 

6. You may use different color schemes 

and fonts.   

7. You should create your own theme for the organization 

and this theme may be used in all of the Office 

applications, including Word and PowerPoint. 

  Hot Tip! Themes change the colors for your fonts, 

charts, fills, and other items. If you use Standard or 

Custom colors, themes will not override your custom work. 

If you use Theme fonts and colors in your formatting, 

these will change based on your theme.    
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Format Painter 

We will use the Format Painter throughout this course.  Let’s format Cell A5 and then use the 

Format Painter to copy this formatting to the other cells. 

 

The Format Painter button:  This time saving button is in the Home Tab’s 

Clipboard group or in the Mini Toolbar.– use your Screen Tip to assist in 

locating the command button as pictured here. Format Painter button allows 

you to apply formats from selected cells to other cells.  Select the formatted 

cells, click the Format Painter button, and select the cells that you want to 

apply the formats.   

 Hot Tip! Format Painter - One click of the command button 

allows you to copy your formatting once.   

Double clicking the Format Painter keeps the Format Painter 

active and allows you to copy your formatting over multiple 

cells or areas; you must re-click the Format Painter button or 

press the Esc key to turn it off.   

This only copies the formats nothing else. 

1. In your budget workbook, Click Cell A5 which should have the word 

Lease in it. 

2. Format your cell– I changed my font to Tahoma, 

added a blue shading, and bolded the cell.  Now, we 

want to apply this formatting to cells A6 – A15. 

3. Make sure you are in cell A5 by clicking it or 

looking at your name box. 

4. Click the Format Painter once. 

5. Your cursor turns into a paint brush. 

6. Click and Drag the cells A6 through A15. 

7. Your cells are formatted as cell A5. 

 

After I accomplished this, I decided the area had too 

many borders so I erased them and then I made Column 
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A wider so the words would be visible.  My completed formatting appears 

here. 

 

Cells Group 

Depending on your screen resolution you may not be able to view the 

Cells Group on your Home tab, if you are then this can save time in 

quickly formatting your cells as the Format cascading menu appears here.  

My Cells Group is displayed here. Using this menu, you may insert or 

delete selected cells, rows, columns, or worksheets. You can change your 

sheet names and Hide and Unhide, too.  This is a time saving little menu. 

 Note: I use other methods such as right clicking and using 

shortcut menus for many of these options, such as I double click 

a Worksheet or Tab name to Rename the sheet rather than using 

the Rename Sheet as displayed here.  I insert columns and rows 

using my Quick Access toolbar or right clicking on a column or 

row header and from the shortcut menu. BUT, you may prefer 

using this neat Cell Group for these items.  
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Undo 

I love Undo; my favorite button in the Microsoft Office Suite! The most 

popular button in the entire Office suite is the Undo button that is 

included on your Quick Access Toolbar. The Undo button records your 

actions and you can undo your actions using this command button, 

including awful formatting.  You can “undo” multiple items using the 

drop-down arrow next to the Undo icon and selecting the first item and 

dragging down the list to the item you want to undo.  Excel will list the 

number of items you are undoing, click the last item you want undone 

and Excel will  undo those multiple actions. 

The Keyboard shortcut for undo is CTRL + Z.  Thankfully there’s the Repeat or Redo key, too, 

or CTRL + Y. 

Insert and Hiding Columns and Rows  

You can always add new Columns and Rows to your existing worksheets.  You may Right Click 

a Column or Row Header and choose Insert from the Shortcut menu or you may use the 

command buttons we added earlier to our Quick Access Toolbar. You may use the Cells Group 

in the Home Tab, too.  

 An Important Gotcha! If your Column or Row is used in a calculation, ALWAYS 

INSERT THE COLUMN OR ROW WITHIN YOUR LIST OF ITEMS NOT AT 

THE END.  Excel may not use your new column or row in the calculation!  

You can hide column or rows by right clicking the selected column(s) or row(s) and choosing 

hide. You unhide and can change the width in the same manner.  Note:  If you hide columns 

or rows and print your worksheet, the printout will not display the hidden column or row, but 

if you print the column and row headers the letters and numbers will not be consecutive – so 

people will know you hid them or that something is afoot. We’ll learn how to protect our 

worksheets later so folks can’t unhide your column and rows, too. 

We will be inserting Columns and Rows and practice hiding them later. 
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Comments 

 Comments are a great way to communicate with others and to remind you of items in your 

worksheet cells. A red triangle in the upper right 

corner of the cell will alert you that a comment 

exists for this cell.  

In the Budget.xlsm and the January 

tab, place your cursor over cell A5 for 

Lease and the comment appears.  

 

Also, notice in Cell A6 of the spreadsheet a little red triangle in the upper right corner of the cell.  

Place your cursor over the cell and you see a comment from me.  

 

The Review Tab in the Ribbon contains the Comments Group for creating new comments or 

inserting comments and after a comment is in a cell for you to edit, delete, and show your 

comments. 

 

A Hot Tip! When I worked on a Sales Vice President’s staff 

in Corporate America in the 1990’s, I “controlled” millions 

and millions of dollars in revenue, compensation, budgets, 

and sales tracking items.  I built tremendous Excel 

worksheets and workbooks.  When I sent the Excel 

workbooks to the regions and branches each month, my 

phone rang off the hook from General Managers and 

Executives about what happened to the numbers.  I learned 

comments and placed comments in cells that I knew would 

generate interest in what happened to the number from a 

previous month.  Even Sales Vice Presidents and General 

Managers can put a cursor over a cell with a triangle (with a 

little training) and read!  My call volume dropped 

dramatically.  
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1. Here’s how to create a comment, activate 

your budget workbook. 

2. Select a cell on your worksheet that you 

want to add a comment – I am using Cell A5 – the 

Lease cell, 

3. Click the New Comment button the Review 

tab OR Right click the cell, receive the shortcut 

menu, and select Insert Comment to add a 

comment to a cell. 

4. A Text box appears for you to type your 

comment – type  in your comment. 

5. When you click away from the cell, the red 

triangle will appear. 

6. Place your cursor over the cell and your 

comment appears. 

 

Once you have the comment in a cell and right click it, you can edit or delete the comment; the 

Comment items in the shortcut menu is pictured here.  Also, with 

the comment cell selected you may use your Comments Group in the 

Review tab to Edit, Delete, Show/Hide, and Navigate through your 

comments. The Comments Group is pictured here. 

 

 If you edit your comment you 

can resize your text box for the 

entire comment to display.  You 

can select your text and use the 

format toolbar to change your font 

and use the other formatting items 

for you comment 
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If you click the Show/Hide Comment item, your comment will continually display.  This can 

cover-up your data and adjacent cells.  You can click and drag the comment box out of the way, 

but having the comment always active may “bother” you, so you can right click the cell again 

and choose Hide Comment. 

   Hot Tip! The Show All Comments button. In the 

Comments group of the Review tab, the Show All Comments 

button will display all of your comments in this worksheet 

and workbook AND all of your open workbooks. You’ll want 

to quickly turn this off using this button; however, it is a 

quick and easy way to display all of your comments. The 

Show/Hide Comment button only hides your selected cell’s 

comment.    

 

Practice by inserting comments, editing them, and Showing and Hiding your 

comments in your cells.  Also, edit your comments with color.  Here’s my 

comments for Cell A6 – Salary. 

 

 An Important Gotcha!  While you may use the Home 

Tab’s formatting groups for some of the formatting in 

your comments, to change the color and other items, 

you’ll have to right click selected text in your comment 

you want colored and from the cascading menu choose 

Format Comments and a Format Comment dialogue 

appears for you to format your font with color and 

other items.  

 

You can Print your Comments, too.  We will examine Print 

Preview, Page Set-up, and Printing in detail later in the course, 

but here’s a quick way to print your comments. 

You may use your Budget.xlsx.  Here’s the steps to view your comments and have them 

printed. 

 

 Comments do not print nor display by default.    
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1. In your Budget.xlsx in the Sheet 1 tab with 

your budget and expenses, click in your budget 

area. 

2. Click the Page Layout Tab and Click the Page 

Setup’s Dialogue Box Launcher or use your Quick 

Access Toolbar’s Page Setup Command button we 

added earlier. 

3. In the Page Set-up Dialogue box, click the 

Sheet Tab, 

4. As pictured here, in the Comments section 

and from the drop-down arrow choose At end of 

sheet (As displayed on sheet may force the 

comment to cover cells that you want displayed 

and your comments must be showing on 

your worksheet), 

5. Click the Print Preview button, 

6. Navigate to the last page using the 

scrolling arrows circled at right.  

7. Your Comments page appears – A 

section of my print preview comments 

page appears here.  

If you needed the Column headers A, 

B, etc and the Row headers 1, 2, etc to 

print in order to know the cells 

containing comments, here’s how --

From the Sheet Tab in the Page Setup 

Dialogue box you can check the Row and 

Column headings option (this is pictured above for you).  

 

If your comments do not cover up data and your comments are showing on 

your worksheet, then you may use the As Dispalyed on Sheet item in 

printing your comments.   
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F2 :   F i l l e r ’  u p  w i th  th e  Au to Fi l l  Ha nd le !  

Perhaps you have heard of Phil Collins, Dr. Phil, or Phil Donahue, Excel has its own time saving 

Fill and efficient tool called the Fill Handle.  I call it the Dr. Fill of Excel. Fills take our old, 

familiar copy and paste functions to a new level of data accuracy and efficiency.  You use either 

the Fill command button on the Home Tab to fill your selection) or through your mouse 

operation.  I’m a click and drag kind of guy and like the mouse method.  So, I will concentrate 

on the mouse method. 

 

Why use the Fill and AutoFill, and what does Dr. Fill of Excel accomplish?  Here are some of 

the magical uses of AutoFill: 

✓ Copy Formula and Functions with or without Formatting to adjacent cells, 

✓ Continue number patterns in adjacent cells, such as consecutive number (1, 2, 3, etc.) 

or multiples of numbers (3, 6, 9 etc) or even/odd numbers (2, 4, 6 etc.), 

✓ Replicate Date Patterns, such as the first of every month or every other Friday, 

✓ Making Schedules and Timesheets, 

✓ Create Custom Lists, 

✓ Activate and use stored Custom Lists, such as Months and Days of Weeks. 

As in formatting, we will use the Fill Handle throughout our course, especially for copying our 

formulas and functions and date series.  Here are some exercises for us to use in getting to know 

Dr. Fill of Excel.  Let’s look at stored lists first and then we will customize our own list.  We will 

look at using Fill for number lists and date series, too. 

Fill  with Months and Weekdays  

1. Open a blank workbook.  

2. Click cell A1. 

You will notice a little, tiny black box in the lower right corner of your cell border.  

This box appears on the corner of your cell(s) that you are working in or have selected.   

Move your cursor over this box and the cursor turns into a plus (+) sign.  That is the 

AutoFill Handle. 
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+ 

Months 

1. Type January  then with the AutoFill Handle, 

2. Click and Drag down slowly, as you drag notice a ScreenTip 

will display February, March, etc. as you drag down. 

3. Click and Drag to December or cell A12. When you release 

your mouse button from dragging Fill, Excel will input the name of 

the months for you. 

4. Wow, see the magic!  Fill can type out the Month abbreviation, 

too, such as Jan, Feb, Mar.  AutoFill can fill horizontally as well as 

vertically. 

 

1. Click cell B1 and type SEP in uppercase – (You don’t have to begin 

with Jan for this to work), 

2. Get your Fill Handle (+) in the lower right border of cell B1, 

3. Click and Drag across to the right to cell M1 or AUG, 

4. Release your Mouse Button; 

5. The abbreviation of the months display for you and AutoFill kept the 

uppercase formatting. 

D ays  

1. Fill knows the Days of the Week, too. 

2. Click cell C2 and Type Monday.  Get your Fill Handle, Click and Drag to 

cell C8 or Sunday 

3. Release your Mouse Button – the full names of the days are displayed 

for you.   

4. Now, in cell D2, type Sat  and fill the abbreviation of the days to cell 

D8. 
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Fill ing in a series of Numbers  

Wait!  Fill gets better and more powerful.  

Co nse cu t ive  Numbe rs  

1. Click in a blank cell, and type the number 1.  

2. Press your CTRL (Control) Key and place your cursor over 

the right hand lower part of the cell on the box for the 

AutoFill handle.  

3. With your CTRL key pressed, Click and Drag down your 

AutoFill handle to accomplish consecutive number. 

4. Excel does consecutive numbering for you and you don’t have to 

begin at 1; you may start your consecutive numbering fill at any 

number. 

 

If you click and drag a number using AutoFill, 

AutoFill copies the number, you may use the Fill 

Options menu to change the consecutive 

numbers with Fill Series. You may use the CTRL 

+ Click and Drag AutoFill, as described above, to 

fill a list of consecutive numbers.  

The AutoFill Options box is circled here. Clicking 

this box provides a helpful menu we will use with 

AutoFill. 

  

Mult ip les  o f  a  Nu mbe r  

Now, let’s accomplish a series of numbers or multiples of a number. 

1. In Cell F2, Type 5 and in Cell F3 Type 10.  

2. SELECT BOTH CELLS (This is an important step – Excel needs to “see” 

your pattern and examine it. Both cells of 5 and 10 need to be 

selected, so Excel will know that you want multiples of 5). 

3. Get your Fill Handle 
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4. Click and drag down slowly – notice Fill will display 15, 20, 25, and so 

on. 

5. Release your mouse button and you have a series of multiples of 5. 

Te xt  w i th  a  Numbe r  

1. In Cell E2, Type Volume 1, 

2. Get the Fill Handle and Click and Drag down, 

3. Notice the ScreenTip – Fill will display Volume 2, Volume 3, etc. 

4. Drag down to Volume 20 

5. Release your mouse button.  

6. Fill Handle can be very smart and looks for patterns in your numbers 

and text.   

 

If Dr. Fill can identify a pattern it will recreate it for you; otherwise, Fill will 

copy your data, functions, formulas, and text!  This is an easy and great 

method of copying continuous information and data. 

Fill ing in Dates 

Co nse cu t ive  D ates  

1. In another blank cell, type in today’s date, i.e. 

03/18/2018,  

2. Get the Fill Handle and click and drag down, notice that 

Excel provides consecutive dates for you as displayed at right. 

Also, notice I began in a year with Leap Year and Excel is so 

smart to recognize that 2020 is a Leap Year. 

3. You can Fill up, too and fill will reverse the order. 

4. In Cell F12 type today’s date and get your Dr. Fill handle 

and click and drag UP.  Notice that the dates will fill in reverse order. 

Bi -Wee kly  o r  o the r  Wee kly  Date s  
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+ 

1. In another cell type in a date and then in the 

cell below it type a date two weeks from the 

date,  

2. Select both cells,  

3. Get your Fill Handle, 

4. Drag down – Dr. Fill will provide dates that are 

two week apart! 

5. Release your mouse and there are your bi-weekly dates. 

Mon th ly  D ate s  

You may use this for the first of every month or other monthly date,  

1. In a blank cell, type in 01/01/2019 in one cell and 02/01/2019 in an 

adjacent cell,  

2. Select both cells, 

3. Using AutoFill, drag across to see fill adding 03/01/2019 and 

04/01/2019, etc.  

4. Release your mouse button after several dates. 

5. This is great for billing dates, payment dates, etc. 

  The trick is to remember to select BOTH cells so Excel can see the pattern you are 

creating, otherwise, Excel will fill in your dates sequentially.   

Excel  allows you to use Fill with bi-monthly, quarterly and other dates. 

Re lat ive  D ate s  

We have used dates that are absolute – that is specific dates (and days) and exact time 

periods.  There are dates that are relative such as the 1st  and the 15th of every month.  These 

dates change based upon the month or week.  Let’s look at how to use Relative Dates in Fill. 

1. In a blank cell type 09/15/2019. 

2. In an adjacent cell type 09/30/2019. 

3. Get your fill handle and fill down for a year of the 15th and last day of 

the months. 
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4. OOPS!  Excel messes up badly and can’t figure out the 1st and 15th of 

the months. By default, Excel uses every 16th day or follows the series 

or pattern of selected dates.  

5. Select 09/15/2019 and 09/30/2019 again,  

6. Fill Down and this time notice the  

Insert Fill Options box, 

7. Click the drop-down arrow and a menu like the 

one here appears. 

8. Click Fill Months and wow – Excel repairs itself 

with the correct dates for you. 

This is a handy feature to know in using custom date series and 

other types of series. 
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Excel 2013/2016 – New 
Flash Fill. 

 

Fla sh  F i l l  
 

A cool feature in Excel 2013 and 2016 is Flash Fill. This separates a 

series in a column for you; this is similar to using the Text to Columns 

feature of Excel, only easier. We will learn Text to Columns later, and 

Flash Fill is a terrific way to separate a series.  

 

Here’s how to use Flash Fill. 

 

1. In my Flash Fill workbook, I insert a column and 

type the person’s Last Name (in this case Frogg).  

2. I press enter to go to the cell below and when I 

begin typing the next person’s last name, Excel 

gives a list of the remaining names in gray. 

3. When I press enter, Excel magically inserts all of the 

last names for me. 

4. Next, I insert another column and type a person’s first 

name (in this case Kermitt). After pressing enter, I go 

to the next cell below and beginning typing the next 

person’s first name, Excel offers all first names in 

gray. I press enter and the first names populate the 

column. 

Sometimes Flash Fill may not work for you. You may use 

your Fill options menu to use Flash Fill, too.  

 

As we learned with the date fill, Excel has a Fill Options 

button that is pictured here.  When you use Fill, this button 

will appear and provide shortcuts to select your formatting 

options and other options. The top item is Copy Cells – I use 

my Fill handle a lot to copy formulas and functions in 

Excel. 
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Select a cell with your formula and click and drag the area to copy your formula too – this works 

when the areas you are copying are continuous.  Using Fill in this manner is like using Copy and 

Paste but in one, visual step. As I wrote at the introduction one of the most powerful and 

productive tools of Dr. Fill is to copying Formulas and Functions.  We will use Dr. Fill in our 

next sections of Forming our Formulas and Putting the Fun back into Functions.  We use Fill 

a whole lot in future sections and exercises. 

Time to learn the true power of Excel’s number crunching machine and that is Formulas and 

Functions. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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F3 :  Fo rmin g  o u r  Fo rmu la s  
 

The third F of Excel is the heart and soul of Excel.  Excel is Excel because of the powerful 

Formulas and Functions that the application uses or that you may produce.  Excel is “Excel-

lent” at providing very complex and very simple built-in functions for you to use or you may 

create your own formulas.  We will build simple formulas first and then use some of the 

functions in our Fourth F of Excel.  Now,  we need to learn how to “form” our own formulas. 

 

In the beginning is the cell.  As introduced at the start of this course, a cell is the intersection of a 

column and row, for example cell A1 is the intersection of Column A and Row 1.  Generally, A1 

is your “home” cell.  If you are in another section of Excel and wish to return to the beginning of 

the worksheet press the CTRL key and the Home key simultaneously.  We have entered text and 

numbers in cells and have formatted them.  Now, we will insert formulas in cells and use the 

cells in calculations. 

 

Formulas and functions in cells begin with the equal (=) sign.  A formula in a cell maybe =2+2 

or =(8*2)+10.  However, in Excel rarely will you use a specific number in a formula.  You will 

use various cell references for your formula to get the numeric value.  

Formulas in Excel follow the order of algebraic standards and the order of operations: 

✓ Items in parentheses are calculated first and work left to right, 

✓ Exponents are calculated next, 

✓ Multiplication and Division numbers/cells are then calculated, 

✓ Finally, Addition and subtraction items are calculated. 

Excel uses common Mathematical operators.  The mathematical operators are: 

Mathematical Operators  
Addition + 

Subtraction - 

Multiplication * 

Division / 

Exponents ^ 
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Symbols in Formulas  and Functions 

Below is a table of symbols and what they mean in formulas and functions.  This will help 

explain and use the syntax that Excel needs in order to work properly for your formulas and 

functions. 

Symbol What it means 
: (A Colon, such as A5:G5) 
=Sum(A5:G5) 

Think the word “Through” or a range of  
contiguous cells, so the sample at left 
would be “A5 Through G5”. 

, (A Comma, such as A5, C10, D12) 
=Average(A5, C10, D12) 

Think the word “And” or specific cells 
that are not contiguous, so at left would 
be “A5 and C10 and D12”. 

() Parenthesis – Cells used in the 
function or you may see a function 
without cells but have the () which is 
needed for the function to work, such as 
=TODAY() – which will put the date on 
the computer in your work sheet and 
update the date automatically for you. 

Specifies the cells or range of cells 
needed for the Function or to separate 
items that need to be calculated in a 
specific order for your formula. All 
functions must have parentheses, even 
with no cell reference. 

! (An Exclamation Point, 
=SUM(January:December!B5) 
This is a 3D reference. 

Think the word Join, The Exclamation 
points joins or connects different 
workbooks, worksheets, and cells in 
Functions and Formulas. 

= Equal Sign, =A5 + A6+B10 
=Count(A5:G5) 

Think “Excel I’m, giving you a formula or 
function.”  All Formulas and Functions 
must begin with an equal sign =. 

$ (A Dollar Sign, such as $B$5) 
Absolute and Mixed referencing. 
=$B5*$I$5. 

Think the word “Only”. Only use this cell 
in a calculation even if the cell’s formula 
is copied to other cells, the cell reference 
will not change.  This is the Absolute 
Reference symbol. 

  



Greg Creech Excelling at Excel: The FUNdamentals Level 1  Page 65 

www.gregcreech.com 

Greg Creech © 2017 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Cell Referencing and Addressing 

Aside from entering numbers for calculations, the primary power of Excel is Cell addressing and 

references:  Cells have various types of addresses and references.  I explain them below and 

demonstrate them in the coming pages.  We will use these types of cell references throughout the 

course.  As we build various types of formulas, we will refer back to this section. 

Relative Address 

Relative Address: A relative address changes the address of the cell relative to its location.  If 

you enter a formula calculating cell B3 as follows =B1+B2 then copy the cell to C3 the formula 

changes based upon the relative address to =C1+C2.  You may quickly and easily copy 

formulas; we discussed this in our previous section Excel F2 – Fills and will use this in the 

upcoming exercises. 

Absolute Address 

Absolute Address: An absolute address of a cell does not change.  The absolute address symbol 

is the dollar sign ($).  If you enter a formula in B3 as =$B$1+B2 and then copy the formula to 

C3 the formula becomes =$B$1+C2.  The absolute address allows you to specify your 

calculation using a specific cell for all calculations.  As an example, if you want your expense 

items to increase by 3%, you would place 3% in a cell and reference this cell in your expense 

calculations using the $ symbol.  When you see a $ in a formula, function, or cell reference think 

the word “only”, such as if you see $A$1 think “only use Cell A1 – do not change this reference 

even if I copy it.” We will use this for our forecast, VLOOKUP, and other functions/formulas 

later 

Mixed Address 

Mixed Address:  This uses both relative and absolute addresses.  If you want the reference in a 

particular column or row not to change and another reference in a particular column or row to 

change, you would use  =$A1+B1 in cell C1 (Column A would be used however the row would 

change).  If you copy this cell to C2, the formula becomes =$A2+B2. 

3-D References 

3-D References: This uses cells in other worksheets.  The exclamation point (!) separates the 

worksheet name and actual cell.  If you want to add January rent and February rent for a total in 
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March, you would enter a formula in the March worksheet as follows:  

=January!B5+February!B5 (Note that your formula bar will guide you through the calculation 

and illustrate your position in accomplishing the formula or function.) We will use this for our 

summary worksheet later. 

 

Confused?  Dazed?  Join the club!  Plan your formulas, play around, and at the final straw 

(usually when you get the #VALUE, #REF, or another error for the 100th time) rely on Help by 

searching on Cell Reference by pressing the F1 key or pressing the Help button. 

 

Since we have had an overview of formulas and cell referencing, we will begin “forming” our 

formulas in our Budget.   

1. With your Budget workbook open, we will input a formula in Cell D5. 

2. Click in Cell D5 and Type (or you may click your cell reference) =B5-C5.  

This will calculate the 

difference between our 

budget and our expense.  

Notice the information is in your formula bar and cell 

3. Press the enter key. 

4. Our calculation appears! 

As you construct your formula, you can type your cell references instead of clicking them if you 

like. We could use our Fill Handle to copy this formula down through the column, but let’s get 

practice manually inputting formulas.  This time instead of typing the formula we will use the 

click method. 

1. Click in Cell D6 and Type =, 

2. Click Cell B6, Notice the Cell Reference of B6 appears in your D6 Cell 

and Formula bar, 

3. Type a – dash or minus sign for subtraction, 

4. Click Cell C6, 

5. Press the Enter key, 

6. Our calculation appears. 
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A Hot Tip!  Now, let’s use the Fill Handle to copy the remaining cells. 

1. Click cell D6, 

2. Position your cursor over the right, 

bottom corner of Cell D6 when you 

see the plus (+) sign Click and 

Drag down to row 15 or if you 

double click Dr. Fill in cell D6 our 

formula will fill to Cell D15. 

 A Hot Tip!  Simply double click the 

(+) fill sign in Cell D6 and the 

formula will fill down automatically 

to the bottom of the worksheet area.  

Fill will go down as far as the longest 

list of data. We’ll use this in some 

productive ways in the advanced 

part of your education.  

Fantastic!  Excel and Dr. Fill have copied your formula and included the 

formatting, too. 

We have calculated our differences between the budget and the expense items.  We will be 

developing other formulas throughout the course.  But we have our foundation for formulating 

our formulas.  Now, to put the Fun back into Functions! 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

  

+ 
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F4 :  Pu t t ing  th e  Fu n  in to   “ Fun”c t io n s  
 

AutoSum 

Now, that we can calculate cells based upon data in other cells - let’s make life easy and 

powerful with built in functions.  We will be using some of the most popular and easiest to use 

functions here and some of the more complex functions later in our course. 

 

On your Home Tab you will see the AutoSum and a Drop-down Arrow next to it on 

your Editing Group and is pictured here.  You may use the Formulas Tab, too 

picture here as well. Use the AutoSum key to summarize a cell range.  Use the Drop-

down arrow to select a common function and this offers you other functions that will 

provide assistance in creating other functions .  If you are a Liberal Arts Major, don’t freak out 

by all of the functions!  If you hate algebra, 

trigonometry, or other mathematical equations just 

the names of some of these functions will scare you.  

If you are an accountant, scientist, engineer, or 

numbers crunching financial analyst you will love 

these scientific, financial, and other mathematical 

wonders, you have found numbers heaven.  For the 

numerical challenged or brave heart take a peek at 

the Statistical Function category and Function 

names.  This intimidates me, but may thrill you!  We 

will use several of the functions.  First, let’s use the 

easy and powerful AutoSum key. 

Ranges of cells may be selected by typing or selecting the first cell, typing a colon (:), and 

typing or selecting the final cell to include in your function.  We can also select a cell and click 

and drag for Excel to select the range for us.   

Sum:  You may type Sum after entering an equal (=) sign or select the cell in which you want to 

Sum and press the AutoSum icon.  Like mathematical magic, Excel enters the =SUM formula 

and will provide the range in which you want to sum!  If the cell range is not correct, use your 

mouse to click and drag the correct range to Sum and press the enter/return key.  The result is 

displayed. 
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Let’s use the Sum function by clicking the AutoSum icon.  

Here are the steps: 

 

1. Click in Cell B14. 

2. Click the AutoSum icon. 

3. The formula:  =SUM(B5:B13) 

should be displayed.  If not, 

you may type the range here or 

click and drag to select the 

correct range.  

4. Press Enter. 

5. Your total appears for this 

range of cells. 

Wow!  Even a “Math Challenged” 

person like me can use this quick and 

easy button to perform totals and subtotals in columns or rows. 

 You may also use the fx -  Insert Function button by the Formula bar 

to activate the Insert Function dialogue box which we will use in a 

moment.  The button is pictured at right.   

 

 

 Write your notes 

here:_________________________________________________________ 

 

________________________________________________________________________ 
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Time to recall our friend the Calculations in the status bar.  As described earlier, the status  bar 

will quickly provide you results of functions, including Average and Sum. 

 

1. With your Budget.xlsx open, 

2. Click Cell B5 and Drag to Cell B13; 

3. The Calculations should show on your status bar based upon our 

selections earlier in the course.  

The syntax for our functions is very important.  If proper syntax is not used, Excel will give you 

error messages or calculate incorrectly.  Here are the important notes  to remember: 

✓ All formulas and functions begin with an equal sign =. 

✓ Parentheses are used in functions to separate the function name from the range of 

cells or  the specific cell(s) that is to be used in the calculation. 

✓ The colon is used to specify a range. 

✓ Other separators, such as commas, may be needed for a function, which we will use 

later with the PMT function. 

Let’s enter the SUM function manually in Cell C20.  Here are the steps. 

1. Click in Cell C14, 

2. Type: =sum(c5:c13) (Notice I used lower case letters, Excel will 

convert the text properly for you.) 

3. Press Enter. 

4. Your result appears. 

5. Click and Drag Cell C5 through C13 and verify the accuracy of the 

SUM function with the calculation box. 

Now, that we have mastered the AutoSum button and the SUM function, let’s use the Average 

function.  
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Other Functions 

Using the Drop-down arrow next to your AutoSum button will provide a list of 

popular functions as well as the ability to activate more complex functions using 

the More Functions… item on this menu.  We will use the More Functions. .. 

later. Below are some of the other functions we will use.  The Average and other 

functions use the same syntax, instead of SUM being in the function other text is 

substituted – the rest of the syntax is the same. 

 

 While I like for Excel to assume certain ranges, care must be given in examining 

Excel’s assumption of ranges to ensure that the range is correct. Don’t assume that 

Excel will be correct. Excel is smart, but not that smart.  

 

Average:  Provides the average of selected cells.  Formatted as:  =Average(B5:B13) or 

=AVG(B5:B13). 

Max and Min:  Provides the largest (maximum) number in a selected range of cells and the 

smallest (minimum) number in a selected range of cells.  (Duh!) 

Count Numbers:  Will do just that:  Count the numbers in 

your selected list of cells, for example, Cell B5 through 

B13 is 9 numbers.  The function displays as 

=Count(B5:B13) 

Let’s use the Average Function is Cell B15 and C15.  

Here’s how: 

1. Click Cell B15, 

2. Click Drop-down arrow next to the 

AutoSum icon, 

3. Click Average,  

4. Excel will “guess” B5:B14 – this is 

wrong! 

5. Edit the function in the Formula Bar as 

pictured at right or in the Cell B15. 
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6. Change the Cell reference from 14 to 13 – Select your number 14 and 

type over it with 13. 

7. Excel provides a scrolling marquee around your function’s cell 

reference and a blue border around your range for you to see the 

range you have entered. ☺ If you are under 50 years of age and have 

good eyesight you may use the blue boxes at the edges of the blue 

selected area to click and drag the cell range reference, too. I’m too 

old and too spastic with a mouse to use this method, but try it! ☺  

8. Press enter. 

9. Your Function is correct. 

10. Using your fill handle in Cell B15, fill this Function over to Cell C15 

and notice that Excel and Dr. Fill will 

change the reference from B5:B13 to 

C5:C13 – this is using Relative Cell 

Addressing or Referencing. 

Now, create your own Count function by 

typing Number of Items in the cell 

below your Average Cell and then enter 

the function as displayed here. I have 

added a row for Travel which we will 

accomplish later so your cell range 

reference will be different. 

Finally, in Cell A17 or A18 use the 

COUNTA function to count cells that are 

not empty or are not blank; this counts 

cells regardless of type of data in the 

cells.  

 Excel will guess your range of numbers for a Function in the following manner:  

✓ If there are numbers to the Left of the function, Excel will assume all of the cells with 

numbers in them to the left. 
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✓ If there are no numbers to the left, Excel will assume numbers above it. Excel will use 

all of the cells with numbers above the cell containing the function – much like the 

Average function included the wrong cell in its assumption. 

✓ Excel doesn’t usually assume or guess a range if it doesn’t “see” numbers to the left or 

above the function cell.   

So we have begun really Excelling at Excel.  Great!  We have our January budget and expenses 

completed!  We will build February through December after we look at our final F - Filters and 

Sorts. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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F5 :   F i l t e r s  a nd  So r t s  

Our final F is Filters and Sorts.  We will learn Filters and Sorts using our Track.xlsx workbook 

file.   

Quickly here are what filters and sorts are: 

✓ Filters provide a quick way of viewing certain information and can include criteria for 

displaying your information. 

✓ Sorts allow you to order your data in various ways. 

Filter is a great way to view information or data based upon criteria and selecting items from a 

drop-down list or pick list.  We will use several different types of Filters, such as Text, Top 10 

and Custom as well as using the powerful and easy drop-down list items. 

Here are the ways to access Filter and Sort: 

✓ The Home Tab the Editing Group contain Filter and Sort Commands, 

✓ The Data Tab includes a Sort & Filter Group, 

✓ Use Command Buttons on your Quick Access Toolbar or your Custom Tab on the 

Ribbon, 

✓ Right clicking and the Filter and Sort items are included in the Shortcut Menu. 

We’ll use all these ways to Filter and to Sort. 

1. First, let’s open the Track.xlsx workbook,  

2. Click the Jan tab. 

Excel Database 

This workbook and worksheets contain a database or data table of information that begins with 

the Header Row (or Field Names) of Order, Date, Customer, etc.  The top area of the worksheet 

is for summary information and titles.  Excel works very differently when used as a database or 

table, like this list of customers.  This is a tracking system or database of information about our 

customer sales and orders.  With your information organized in this fashion Excel works great 

with items such as sorting, filtering, sub-totals, Pivot Tables, and other items we will examine.  

An Excel database contains a row called Column Headings, I like to think of this as our field 

names for our “simple” database, all rows beneath this row contain only data or a calculation, 

but not sub-totals or blank rows.   
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   Hot Tip! Rules for a data table in Excel: 

1. One Row (and only one row) is your column 

headings/field names and should be text; rows 

underneath this top row are for your data. 

2. No blank rows or blank columns and avoid empty cells, 

especially in the first and last columns of your table. 

3. The table cannot be adjacent to other Excel rows, 

columns, or cells that have information or data; you 

should have blank rows and columns surrounding your 

table.  

These guidelines and rules are easy, but steadfast.  
 

 An Important Gotcha! Remember your Excel table or database should not contain 

blank rows or columns; you may have blank cells but not blank rows or columns.  

Excel considers a blank row or column to be the end of your database or table.  

Click the Income Tab in the Track.xlsx file. 

This worksheet is not a database and is not good with filtering and sorting.  This worksheet is a 

typical type of Excel worksheet with items being totaled and sub-totaled in rows and columns.  

Many balance sheets, income statements, and other financial data uses this type of format. You 

could Sort a specific area, such as A7 – G11, but not a column or other area.  Filtering would not 

be useful in this type of worksheet, either. 

Filter through A List  

 You should be in your data or table area and near your header row in order for Excel to 

know how to and what to filter. Otherwise, Excel will give you an error that it could not find a 

list; therefore, be in your table area.  

Let’s get ready to Filter our database or table in many neat ways. 

1. In your Track workbook, 

2. Click the JAN worksheet 

3. Click cell C8  – the first cell under your Customer Field name or column 

heading.  

4. Scroll to find Computer Tech and select a cell with Computer Tech. 
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5. Click the AutoFilter button that we added to our Quick Access Toolbar. 

Quickly AND easily Excel displays only the orders for Computer Tech. 

The AutoFilter will filter for whatever you have selected and turn on 

your Filter (the arrows next to your field names 

or column headings), as displayed above.  

 

  Hot Tip: Filtering/Sort using the 

Short Cut menu. When you right click 

on a cell, the short cut menu contains 

Filter and Sort commands. Similar to 

AutoFilter, you may quickly filter for 

the data in a cell using the “Filter by 

Selected Cell’s Value” option. Using 

Sort, you may reorder your data in 

various ways based on the column you 

are in. Custom Sort allows you to sort 

by multiple columns, which we will 

learn, soon.   
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Without using the AutoFilter button or short cut menu, here is how to Filter for 

Computer Tech (or any other client). 

1. If  your filter arrows are not on, in the Home Tab,  

2. Click the Sort & Filter command button,  

3. Trace to Filter and Click it. 

As pictured, small drop-down arrows appear in your column headers or fields.  

1. In the Customer header, 

2. Click the Drop-down arrow, 

3. A menu of your Customer Names appears.   

4. Click the Select All check mark item to 

deselect all of your items, next click the Computer 

Tech box, 

5. Click OK,  

6. Excel displays only Computer Tech.   

Filters will display only certain information for you.  The data 

is not deleted and when we remove the filter all rows will 

display again.  

1. Notice the drop-down arrow has turned into 

a Filter button, this indicates that a filter is on for 

this field and a screen tip appears alerting you to 

the criteria for this filter. 

2. Click the drop-down arrow, 

3. To view all of your data 

again without turning off the 

Filter, Click the Select All box 

– You may need to scroll up 

to see the All selection. 

4. Click OK and all of your customers and their data appear again. 

5. Click the Sort & Filter button and from the menu click the Filter item to 

turn off your filter. 
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6. Notice that when you have your data filtered, the Sort & Filter button 

on the Home Tab activates Clear and Reapply for you. You 

may remove your filter by clicking the Clear button and 

then you are ready for additional filters. You may use the 

Clear button we added to your Quick Access Toolbar, too.  

 

 

 

 

 

 

 

 

 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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If you prefer, you could use the Data Tab to Filter, too. 

1. Click in your Customer list on the Jan tab, 

2. Click Data Tab and click the Filter Button in the Sort & 

Filter Group,  

3. Excel activates the Filter’s drop-down arrows for your 

Column headers or Field Names. 

4. Click the Customer arrow and click the Select All box 

to deactivate your selections,   

5. Click the check boxes of a few customers whose 

data you would like to view, 

6. Click OK. 

7. To view all of your data again, click the Clear 

button in the Sort & Filter Group of the Data 

tab.  The Clear Filters button becomes active 

when you have a filter on. 

8. Try several different selections for 

specific dates, amounts, and other filters based on your 

selections.   

 

 An Important Gotcha! Notice that you have two entries for ABC Co. Databases 

and data tables are very literal and must have consistency.  Databases and Data 

tables/list won’t make assumptions and spaces and periods count in names of items.  

Excel has a terrific feature entitled AutoComplete. (This item is found in the Excel 

Options and the Advanced section and the Editing Options has the AutoComplete 

enabled checked for you. We’ll look at these options later.)   If you begin typing a 

name that Excel can recognize from your list, Excel will display that for you to press 

enter to accept the entry automatically for you. For example, if you go to Cell C83 and 

type Com  - Excel will display Computer Tech for you to accept or to continue typing 

your own name.  Please use AutoComplete or be very consistent in your names and 

other items.  
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Multiple Fi lters 

Let’s filter the filter and then filter our filtered list! 

1. Have Track.xlsx  open and the Jan Worksheet is active, 

2. Turn on your Filters, if you need to,  

3. Click the drop-down arrow for Customer and from the cascading 

menu click the Select All box to deselect everything.  

Next, click the Computer Tech box to display only 

Computer Tech’s information,  

4. Next, Click the Drop-down arrow for Total and 

deselect all of the items and Click $200. 

5. Only Computer Tech totals for $200 appear.  We 

have two criteria, now, for our filter. 

6. Click the Drop-down arrow for Date and from the 

list choose January 20. 

7. You now only see one row that meets the criteria 

of Computer Tech, $200, and January.   With the date 

notice the ways you may filter by year, month, and date. 

 

 Hot Tip! Clear a specific filter - 

When you have multiple filters on 

you can remove specific filters easily 

through the drop-down arrow on a 

field that is filtered.  The short cut 

menu here appears – notice the Clear 

Filter From “Customer” – Excel 

would remove this filter but keep the 

other filters for you.  
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Top 10 

Excel’s Filter can make Top and Bottom number lists easy.  You can specify whether you want 

items or percentages.  While the name says 10, you can specify the number you wish.   For 

example, if wanted the top 12 revenue producing clients you could specify a total column to 

show only the top 12 items.  If multiple numbers meet the criteria or a tie, Excel will not stop at 

the number you specified.  For Example, if your top 12 list include 3 clients with the same billing 

in the 12th spot – Excel would display your top 14 instead of 12.  Excel won’t make the 

assumption about which client you would prefer to see given a duplicate. 

 

Let’s filter for our top 6 billing days for our orders.  

1. With Filter active on your Jan tab of the Track.xlsx workbook,  

2. Click the drop-down arrow for Total, 

3. Trace to the Number Filters item, 

4. Click the Top 10 item from the list, 

5. The Top 10 AutoFilter Dialogue box appears, 

6. Ensure Top is displaying 

– you may also look at the 

Bottom or lowest items – in 

our case here, we could look 

at the 5 lowest billing 

accounts (losers!).  

7. Next, from the number area change the 10 

to a 5 using the spinner control or typing in 5, 

8. Next, keep the Items displayed as pictured 

above you may also Show by Percent, 

9. Click OK. 

Great! Now let’s sort the list From Largest to Smallest. 

1. Using the Filter Drop-down arrow for Total and 

clicking Sort Largest to Smallest – Excel sorts 

this for us from the greatest amount to the least amount.  
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2. Notice that your list has more than 5 – there are multiple $5,000 at 

the 5th mark so the list expands.  Filters continue your list when you 

have duplicates.  

 

 Hot Tip! Filter information and AutoCalculate - Remember 

the Calculations in your status bar?  Select your list in the 

Total column and notice your Sum, Average, and Count 

functions in the status bar, if you have these items activated. 

Also, with a Filter active you should notice the information at 

the left of the status bar displaying 8 of 88 records 

illustrating the number of items that meet your filter criteria 

and are displayed. These items will aid in further analyzing 

your filter information.  

3. Remove your filter by clicking the Clear button on your Data Tab or 

Quick Access Toolbar.  

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Custom Filters  

You can specify a range of items for the filter to apply.  You can have dates, numbers, and other 

items filtered with a range.  We will create a filter that will display our mid-range billing clients.  

Depending upon the type of data that exists in a column Excel provides different type of filters.  

We’ll look at different filters for different types of data such as Text, Numbers, and Dates. 

Number Custom Filters  

Let’s filter for a range using the Total column. 

1. The Track.xlsx file is open and Filter is 

active,  

2. Click on the drop-down arrow for Total 

notice all of the number filters such as 

Great than and so on.  

3. Click Between. . . , 

4. The Custom AutoFilter dialogue box at 

right appears. 

5. Using the dialogue box 

as a guide, ensure 

Excel provides is 

greater than or equal 

to, then press Tab Key 

or Click the second box, 

6. Enter 250 or use the pick list from the 

arrow to select 250, 

7. Ensure the And radio button is on, 

8. Press the Tab key or Click in the next 

box, 

9. Ensure “is less than or equal to” appears 

and Tab  to or click the next box, 

10. Enter 2500 or use your pick list by 

clicking the arrow, 
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11. Click OK. 

Your range of customers appears. 

Sort Descend this column using the sort descend button on the Data 

Tab or the Filter drop-down arrow for the Total Column. 

 

Text Custom Filter  

Let’s use Filter for Text characters. 

1. If there are any filters on your Jan tab, click the 

Clear Filters button in the Data Tab or on your Quick 

Access Toolbar to remove all filtered data. 

2. Click the Filter drop-down arrow for Customer, 

3. Trace to Text Filters and from the cascading menu, 

notice the different type of text criteria you may provide.  

4. Click the Custom Filter. . . item. 

5. The Custom AutoFilter Dialogue box opens.   

6. We want to view two different letters for our customer names.  We 

want all customer’s whose name 

begins with an A or contains oo.  

7. Using the screenshot as a 

guide make your choices and 

make sure you change the And 

selection to Or – the Or allows 

two different criteria for the 

same filter. 

8. Click OK. 

9. Only customer’s whose name begins with an A or have “oo”  

somewhere in the name appears. So, we have A.B.C. Co, Adam, Allen 

and Lucy Goosey, Shoot Pool, and so on.  Contains is a terrific filter 

because no matter where the character resides in the name Excel 

displays the name. 
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10. Click the Sort Ascending button on the Data 

Tab or using the Filter button by Customer and 

from the menu selecting Sort A to Z.  

11. You may clear your filter from here or Click the 

Clear button on the Data Tab.  Clear your filter. 

 

Date Custom Filters  

Excel has great built in Date Filters for you. Using the Date filter menu, you may filter for 

relative dates, such as Yesterday, Last Month, etc. or absolute dates using the check boxes for 

year, month, and day or using the Before, After, and Custom Filter, which we will accomplish 

now. 

1. With your Track.xlsm workbook open and at the Jan tab ensure you 

have no filters on your data but do have filter 

active. 

2. Click the Filter arrow for date and trace to Date 

Filters.  Notice ALL of the ways to filter your 

date lists. 

3. Click the Between. . . item and the Custom 

AutoFilter Dialogue Box  opens.  

4. Ensure that the Show rows where: Date item is set to is after or equal 

to and type or use the calendar pick list to enter 01/10/2017,  

5. Keep the And  button selected, 

6. In the second set of boxes, 

ensure Date item is set to is 

before or equal to and type or use 

the calendar button to enter 

01/20/2017, 

7. Click OK. 

8. Your data filters for that range of dates. 

9. Click your Filter arrow for Date and from the Menu Sort Oldest to 

Newest. 
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10. Click your Clear Filters button to remove all filters. 

Yes/No Filter 

I like to have a yes/no column for many of my worksheets that I use for tracking items.  One way 

I use yes/no is if a customer has paid me or not.  This is a very quick and easy way to follow-up 

on payments.  I filter for Yes to send a thank you note and I filter for No to place a follow-up e-

mail or phone call.   

Let’s filter our list for who has not paid us, yet. 

1. Click inside our data table in the Jan Tab of the Track.xlsx  file, 

2. With all of your records showing, click the drop-down arrow on the 

Yes/No Column and uncheck the Select All item, 

3. Click the box to check No, or select a cell with  No in it and click your 

AutoFilter button, 

4. Click OK. 

Now, we know who to phone or e-mail a follow-up to collect our money. 

Let’s determine our outstanding collections. 

1. Sort your Total filtered list from Largest to Smallest.  

2. Click and Drag the Items in the filtered Total Column to select them, 

3. Notice your Calculation area in the status bar (I obviously need to 

make some collection calls!), 

4. I have all of my functions on and see the results for No payment. 

 

5. I think I would get busy calling some clients asking: “Show me the 

Money!”, especially Bates Motel. I need to send my collections agent 

to visit Norman! 

Filtering displays only the information you select.  Sorting displays all of your data arranged in 

a particularly order.  Time to “sort” things out. 
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Sorting 
 An Important Gotcha! Always have a backup copy of your Excel file before 

performing sorting!  You can use the Save As feature from your File Tab or pressing 

the F12 key activates the Save As dialogue box for you, too.  While sorting is powerful 

and easy in Excel, many a new user and us old-timers are frustrated because 

sometimes you may need to select your entire area of data to sort; otherwise, Excel 

will sort only your selected information, such as a single column, and the information 

will be misplaced in your original data worksheet!  Excel 2010 through 2016 handles 

this better than previous versions of Excel.  If your worksheet is a database or table 

then you will not have to select the entire area in order to sort– simply be in the 

column of the field you want sorted.  If your worksheet is not in a database or table 

format, such as a balance sheet or income statement with multiple subtotals, you will 

need to select an area to sort prior to sorting the data area.  For example, you may not 

want a total or sub-total row included in a sort because your information will be 

distorted. In our worksheet, the Customer data listing is in a continuous list without 

sub-totals and totals and all rows and columns are together and have data in most 

cells, so our sorting will be easy.     

Our first step is to ensure that we have a backup file.  You could sort your worksheet incorrectly 

and click the save button and you may never be able to return to your original sort unless there is 

a column that you can sort on and retain.  For example, I had a customer that used Excel for 

tracking invoices, the customer wanted to keep the order of the spreadsheet in order of input – 

there was no column or field that kept track of the order of input.  The client performed a sort on 

client name, the client accidentally saved the workbook, closed it, and when she reopened the 

file, the customer could not get back to the original order of input.  OOPS! Now, the client uses a 

number field to keep the order of input and to allow a sort on this field. 

Unless your worksheet contains a table with no totals or subtotals or  other calculated row and no 

blank rows or columns, you will need to select or  highlight the entire area of data on your 

worksheet leaving no columns or rows unselected or highlighted in our data area.  We will sort 

two ways:  First, we will use the Sorting buttons on the Home Tab and Data Tab as we 

accomplished with our filtering exercises. Then, we will use the Custom Sort method in order to 

sort by more than one field or row header.  We will sort a database/table that we will not need to 

select the area for sorting and then we will sort an income sheet that we will need to select an 

area in order to sort.  
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Sorting Command Buttons: A Single Sort  

Here are the steps for sorting using the Command buttons on the Home 

Tab and Data Tab. You may use your sorting buttons 

that we added to our Quick Access Toolbar and you may 

use the Shortcut menu by right clicking, too. 

1. First, in our Track.xlsx file and Jan Tab, 

2. Click cell C8 or any cell with a name 

under the Customer heading, 

3. Click  the Sort & Filter button and Click the Sort A to Z 

item. 

4. You may use the Data Tab and the Sort Ascending 

button in the Sort & Filter Group. 

5. Excel sorts your table by customer name in alphabetical order. 

 

 A Hot Tip! Notice that Excel changes your sort to A to Z and 

Z to A for Text data, Newest to Oldest and Oldest to Newest 

for Date data, and Largest to Smallest and Smallest to 

Largest for Numerical data!  So, this is Sorting for “Dummies” 

and Liberal Arts people like me.  

 

  This worked well because the area we are using is a tracking system type of worksheet.  As 

I related earlier, there will be times when you will need to select the area you want sorted and 

we will accomplish this in our next section. 

 

Click the Undo button on your Quick Access Toolbar to remove the sort. 

 Here’s one of my favorite buttons in the Office suite the Undo icon.  It should be called the 

Greg Creech key because I make so many mistakes and say Oops! a lot.  Clicking this key can 

get you out of a mess.  Since we clicked it, our sort is removed. 
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Let’s sort in Descending order or from Greatest to Least as we have previously accomplished. 

1. Click in Cell G8 we want to view our Totals from Largest to Smallest. 

2. Click the Z-A button on the Data Tab or the Largest to Smallest 

button.  Excel sorts our information for the largest to the smallest 

amounts. 

 

Let’s sort in Date order or from Oldest to Newest using the right click method. 

1. Right click in the Date 

column,  

2. From the shortcut 

menu, trace to Sort 

and from the 

Cascading menu 

choose Oldest to 

Newest as displayed 

here. Excel sorts your date in chronological order. 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Custom Sort: Sorting by Multiple Items 

Let’s use the Custom Sort method of sorting to sort by more than one column.  Although the 

Sorting Command buttons are quicker, they are designed for sorting by only one item.  The 

Custom Sort method of sorting allows you to have a primary sort and other sorts.   

Here are the steps to sort using the Custom Sorting: 

 

1. First, be in our Track.xlsx  file and Jan Tab,  

2. Click inside your data table, 

3. Click on your Data Tab and Click the Sort button and your Sort 

Pane opens. You may use the Custom Sort button on your Quick 

Access Toolbar that we added earlier, too. 

4. Click the Drop-down arrow for our first sort.  Notice you can 

select different areas to sort by such as Order, Date, etc.  Also, the 

“My data has headers” is checked.  The Header row is important in 

the ease of sorting; if there were no header row Excel would have 

Column A, Column B, etc. for you choose – Descriptive names are 

easier for me to relate rather 

than Column A, Column B. I 

think of these column 

headers as field names of 

my database. 

5. Click Total,  

6. Ensure Sort On has 

values in it. Notice that you 

may sort by color and icons, 

too. 

7. Order should be Largest to Smallest. 

8. Click the Add Level Button, 

9. In the Then by box select Customer, keep sort on Values, and Order 

should be A to Z. 

10. Use the screen above to add sorts for Date and Order.   



Greg Creech Excelling at Excel: The FUNdamentals Level 1  Page 91 

www.gregcreech.com 

Greg Creech © 2017 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

11. When complete, click Ok. 

 

Scroll through and notice how your sort works when you see duplicates in the total field. 

There are records or rows that meet all of the criteria. Let’s Sort the worksheet by Order and 

then by Date. 

1. Activate your Sort Dialogue box 

by clicking the Sort command 

button on the Data Tab, 

2. Click in the Sort by box for Total 

and then click the Delete Level 

button to remove the primary 

sort, 

3. Next, click the Delete Level button to delete the Sort by for Customer, 

4. Click OK. 

 

Now, let’s select an area to sort. 

1. In the Track.xlsx workbook, click the Income Tab, 

2. This worksheet would not be good to sort without selecting the correct 

area first.  There are no headers or field names and there are breaks in 

the data for calculations – so this is not a database, and we must select 

areas to sort. We have blank columns B and F. 

3. Select the Expenses area A7 

through G12.  

4. Click the Sort Ascending button 

and Excel sorts your information 

by the Expense name, since our 

focus or cursor was in this 

column. Excel will sort based on 

the “white” cell as pictured here. 

You may press tab and the focus 

leaves this cell and then you can 

sort by the next column using the buttons, but having the area A7 

through G12 is the important part of this.  
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5. Tab to Column G, 

6. Click the Custom Sort button and from the Sort Pane Sort by Column G 

on Values and Order from Largest to Smallest. 

 

Excel sorts your Year-to-Date expenses in descending order or Largest to 

Smallest for you. 

 

Congratulations!  You have survived and thrived through the Five F’s of Excel:  Formatting, 

Fills, Formulas, Functions, and Filters/Sorts.  We will continue using these Five F’s 

throughout our course and expand on all of our 5Fs.  Now, let’s turn our attention to some 

Excel efficiencies and to creating a multiple worksheet file. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Excel 2013/2016 – New 
Quick Analysis Button 

Quick Analysis  

When you select an area in Excel, 

Excel 2013 and 2016 provide the 

Quick Analysis button. From this 

button and the menu, you may use 

tabs for Formatting, Charts, Totals, 

Tables and Sparklines.  

 

  Hot Tip! Always select the area of your worksheet 

first and then use the Quick Analysis menu for your 

choice.    

1. Using my Budget workbook, I select cells B5 through 

C14 and the Quick Analysis button displays.  

2. I click the button and from the menu click the Totals 

Tab and then the Sum function. Excel inserts the 

function for me in cells B15 and C15.  

3. If I try to use another function, Excel warns 

me that I may overwrite existing 

information. With my area selected, I’m 

using Sparklines for my Difference column. 

 

You may use these tabs and buttons to create 

Conditional Formatting, Charts, and Tables using 

this neat, new Excel Button. We will learn Charts, 

Conditional Formatting, and Format as Table later 

and we will use the Quick Analysis button. 
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Worksheet Organization  
 

Wo rk sh ee t  Ef f i c i en c i es  a nd  Na v iga t ion  
 

Worksheet Tabs  and Shortcuts 

Open or return to your Budget workbook.  January is complete.  Now, we need February, March 

and so on.  Are we going to build each month separately?  And we want an Annual spreadsheet 

that we can sum each month for each Budget and Expense item for the year.  Are we going to 

build an Annual worksheet and input all of these figures?  No way! 

 

 First, to Insert A New Worksheet you can click the New 
Worksheet tab at the end of your worksheets and Excel 
promptly creates a new sheet for you.  

We will use the efficient and handy method of right clicking or secondary mouse clicking on a 

worksheet tab at the bottom of the screen.  When you Right Click or use your secondary mouse 

button to click a worksheet name a shortcut menu appears.  Here is a synopsis of each item on 

the menu. 

Insert:  Will insert an object.  A dialogue box will appear with a 

worksheet selected as the default, but you may insert a chart or 

other object.  If you select worksheet, a new, blank worksheet 

appears with the next worksheet number.  

Delete:  Will delete the worksheet or selected worksheets in which 

you are working and the one in which you right clicked to get the 

shortcut menu.  You can select multiple worksheets to delete. Excel 

prompts you to make sure that you want to delete this worksheet.  

BE CAREFUL!  When the dialogue box says permanently, it means 

permanent, as in forever, AND THE UNDO WON’T WORK. 

Rename:  Will allow you to rename your worksheet from Sheet 1 

or Sheet 2 to a more meaningful name for your data.  As we have 

accomplished, I simply double click the tab I want to rename to 

give the worksheet a new name. 
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 Important Gotcha! Worksheets cannot use special characters and the same name 

cannot be used twice, so no duplicate worksheet names. Excel limits you to 31 

characters in a worksheet name.  

Move or Copy:  Will move or copy your sheets. (Although clicking and dragging your sheet(s) to 

move them is easier with only a few sheets visible) or to create a duplicate of your selected 

worksheet(s) through pressing the CTRL key as you click and drag the sheet(s). We will copy 

our worksheet(s) using the menu method and the CTRL + Click and drag method. This menu 

allows you to copy worksheets within the same workbook or to copy worksheets to another open 

workbook or to a new workbook. 

View Code:  Will take you to the Visual Basic programming area 

and allow you to program in Visual Basic for your worksheet.  WE 

WILL NOT BE TOUCHING THIS ITEM; this is beyond the scope 

of this section – we will look at this with Macros . 

Protect Sheet:  Will activate the Protect Sheet box for you to set a 

password and decide what users may or may not accomplish with a 

protected worksheet. We will use this later in our course. 

Tab Color:  Allows you to receive a color palette and select a color 

for your worksheets.  This permits you to color code your sheets.  

Hide/Unhide Worksheet You may hide a worksheet by right 

clicking on the worksheet name and choose hide from the shortcut 

menu. You may unhide a worksheet by right clicking on a sheet and choose 

Unhide and the box at right appears for you to choose the Worksheet to 

Unhide. I had previously hidden January, March, and June. 

Select All Sheets:  Will select all sheets for you to format, change, and make 

other GLOBAL edits to your worksheets with one action.  Use this with care.  

We will use the Shift Click method to select contiguous worksheets in which we want to work or 

make a global change on all of our worksheets. We will use CTRL + Click to select 

noncontiguous worksheets that we may want to change or to print. 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________  



Page 96 Excelling at Excel: The FUNdamentals Level 1  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2017 
No Duplication Permitted  404-403-5391 

 

Important helpful tips for worksheet organization. 

✓ You can click and drag a worksheet to move it.  Click the worksheet tab and a piece of 

paper will appear and a dark arrow will illustrate where you are moving your 

worksheet. 

✓ A Hot Tip!  You can copy a worksheet and move it at the same time by pressing 

your CTRL key, Click and Dragging the worksheet tab you want to move (with your 

CTRL key continually pressed) – A sheet with a plus sign will appear and a dark arrow 

will illustrate where you are copying your worksheet.  Release the mouse button and 

CTRL key and a new copied worksheet appears ready for you to rename.  If you select 

a group of sheets to copy, ALWAYS CLICK THE SELECTED OR ACTIVE 

WORKSHEET TO CLICK AND DRAG TO COPY, otherwise Excel won’t give you the 

copy button nor will it copy your sheets. 

✓ You may rename a sheet by double clicking directly on the Sheet name; this will 

highlight the sheet name ready for you to type a new name. 

✓ You may select continuous sheets by clicking one sheet, pressing the Shift key and 

keeping it pressed, click another sheet and the sheets in between select for you. 

✓ Selected sheets appear in gradient white.  Non-selected sheets appear in blue, grey 

(depending upon your Windows color scheme) or a color of your choice.  When you 

have sheets selected the word Group appears on your title bar with your Excel file 

name. 

✓ You may select sheets that are not continuous using the same method as above, 

EXCEPT Press the CTRL key and Click the Sheets you want to select. 

We will use many of the methods described above.  We have our first month completed and will 

copy this sheet to produce our budgets and expenses through December. 

 

Here are the steps to copy your worksheets and create a budget/expense worksheet for each 

month. If you haven’t, let’s rename Sheet 1 to January. 

1. Have your Budget workbook file open on your budget/expense tab 

for January. 

2. First, if we haven’t already, we need to rename Sheet 1 to January. 
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3. Double click Sheet 1’s name and the name will highlight for you to 

type over it – type – January. Or, you may rename Sheet 1 to January 

by right clicking the Sheet1 tab and 

selecting the Rename option on the 

shortcut menu– Type January.  

 

Let’s change the Tab Color for January.  

1. Right Click on the January Worksheet 

tab and from the short cut menu trace 

to Tab Color and from the cascading 

menu select a color for January. 

 

Let’s copy January. 

1. Right click on the January tab, the 

short cut menu appears, and click Move or Copy.  

2. The Move or Copy dialog box appears as shown here.  Notice the To 

Book section where you may use the arrow to choose open books or a 

new book to move or copy your 

active and/or selected 

worksheet(s). I find this very 

helpful.  

3. Don’t change the To book box – 

keep this copy in your Budget 

workbook.  Select Sheet1 (or you 

may have another Sheet number) in 

the Before sheet box and 

click/select the Create a copy 

option.  Very Important:  There are 

times I wish that Microsoft had 

made the Create a Copy dialogue 

box checked by default.  But, alas, we must check it. 
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4. Click OK and Excel creates a duplicate of January and names the 

worksheet January (2) 

5. Now, rename the January (2) worksheet to February by Double 

clicking the January (2) tab and typing February. 

 

Let’s change the Title in our worksheet in Cell A2 from January to February. 

Click Cell A2 in your February sheet and using the Formula Bar or within the 

cell, select the word January and edit it to February. 

 

Let’s copy more than one worksheet, we will copy January and February to make March and 

April at one time.  

1. Click the January tab, press the shift key and keep it pressed as you 

click the February tab.  These sheets will turn gradient color alerting 

you that they are grouped and the word group will appear by your 

Excel workbook name on the title bar.  You may release your Shift key 

and release your left mouse button; the worksheets remain grouped. 

2. With your January and February worksheets selected, right click on 

your January worksheet tab and choose the Move or Copy item; the 

Move or Copy dialog box appears, 

3. Select Sheet1 in the Before sheet section and ensure Create a copy is 

selected with a check mark, 

4. Click OK. 

5. Now, you have a January (2) and February (2) worksheet. 

6. If you need to ungroup your sheets, right Click on any sheet tab and 

your shortcut menu will have Ungroup Sheets as your bottom 

item, now.  The Ungroup Sheets item will not appear unless you 

have 2 or more sheets grouped. 

7. Rename them to March and April by double clicking them 

or using the Shortcut menu method – whichever you prefer. 

8. Change your headings in Cell A2 to the correct month. 

 

Now let’s create May – August.   
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1. Select January through April worksheets by clicking January – 

pressing your shift key and clicking the April worksheet.  Your 

worksheets’ tabs should turn gradient colored and are selected for 

you.  Release your shift key and left mouse button. Your January 

through April sheets select for you. 

2. Next, right click on the January worksheet tab, click the Move or Copy 

item, and the Move or Copy dialog box appears.  Select Sheet2 in the 

Before sheet section and ensure Create a copy is selected with a 

check mark, 

3. Click OK. 

4. You should have January (2), February (2), March (2) and April (2) 

worksheets.  Rename these worksheets to May, June, July, and 

August. Don’t forget to change your headings in Cell A2. 

 

Let’s use the CTRL Key and Click and Drag method of copying worksheets.  This requires 

good mouse skills and is a great time saver for quickly copying worksheets. 

1. Click the May Worksheet, 

2. Press your shift button and with your shift button pressed click the 

August worksheet, 

3. The May through August worksheets should appear in white and are 

grouped.  Release your Shift button and your mouse button – the 

sheets remain selected and grouped. 

4. Press your CTRL (Control Key) button on your keyboard and keep it 

pressed, 

5. Click May or whichever sheet is selected and active, 

6. Your cursor changes to sheets of paper with a plus (+) sign.  Keep 

your finger pressing the CTRL Key and one finger pressing your left 

mouse button. 

7. Now, move your cursor/mouse over to the right – as you move, notice 

a dark arrow that 

displays where you are 

copying the sheets.  
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You are continually keeping your Control key pressed with your left 

mouse button. 

8. When your cursor displayed as the sheets of paper with a plus sign 

are between the August and Sheet 2 tabs, release your mouse button 

and then release your CTRL key. 

 An Important Gotcha!  Release your Mouse button first to copy your sheets, if you 

release the CTRL key before your mouse button, your sheets will move not copy!  

1. You should have May (2), June (2), July (2), and August (2) 

worksheets. 

2. Rename them to September, October, November, and December. 

3. Also, Change cell A2, your heading cell, on each worksheet to the 

appropriate month. 

4. Make sure you have the same data except for the month and 

worksheet name on each worksheet. 

5. Save your workbook. 

 

A Few Hot Tips - Reminders!  

1. You can scroll through your multiple worksheets quickly by using the CTRL  

(Control) Key and pressing the PGUP and PGDN keys. 

 

2.  You can right click on your Navigation buttons and view your sheet names  

January through December to quickly go to or activate a sheet. 

 

3.  Before you copy your worksheets and use a worksheet to sum the data.  

All worksheets must be identical!  The following work that we will do will not 

be accurate if Lease expense and budget are not in the same cells on every 

worksheet.  Consistency is necessary in creating a worksheet that sums 

multiple worksheets. 

 

So, we have January through December’s budget.  Time for our annual budget. 

 

 Write your notes here:____________________________________________________________________ 

  



Greg Creech Excelling at Excel: The FUNdamentals Level 1  Page 101 

www.gregcreech.com 

Greg Creech © 2017 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Isn’t that Special? The Copy Cat,  Clear,  
Paste Preview and Paste Special  

In our last exercise, we copied a part of a worksheet and we have copied worksheets individually 

and through grouping.  There are four ways to cut (move) and to copy (duplicate) a cell or range 

of cells.  Here are the ways of moving or duplicating information in the Office Suite, including 

Excel.  The first step is to select the range of cells, rows, columns, etc. that you want to move or 

to copy.  We have already copied worksheets and a range of cells, so we will review and perhaps 

give you new ways in which to use copy/move and paste. We will examine the  

Paste Preview feature that provides a live preview of your paste before you click to paste. 

  No matter the method of moving or copying information that you prefer the procedure 

always begins with selecting or highlighting your cells, rows, columns, objects, worksheets, 

etc.  Then using the method you want to use to move or copy information.  Indicating with your 

cursor where you want the information moved or copied to.  Finally, you choose your paste 

method to move or copy the information.   

The four methods of cut (move) or copy are: 

✓ Home Tab Command Buttons (or Cut/Copy buttons you may have added to 

your Quick Access Toolbar or custom tab), 

✓ Keyboard Shortcut (CTRL + C to copy, CTRL + X to cut, and CTRL + V to 

paste), 

✓ Shortcut Menu (Secondary Mouse Button or Right Clicking), 

✓ Click and Drag to move or CTRL + Click and Drag to copy. 
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Home Tab  Co mma nd  Bu t to ns   

1. Select or Highlight your item(s) or cells, 

2. Click the Cut (Scissors to move) OR the Copy (Pieces of paper 

to copy) button, 

3. Click your cursor or insertion point where you want the 

item(s) placed, 

4. Click the Paste (Clipboard) button. You receive the Paste 

Preview options to select the type of paste you wish.  Excel 

provides a live preview of your paste as you hover over the 

items for pasting. We will examine these in more detail in our 

next section. 

 

Keyboa rd  Sh or t cu t  

1. Select or Highlight your item(s), rows, columns, and/or cells, 

2. Press your CTRL key and X key on your keyboard to Cut (Move) or your 

CTRL key and C key on your keyboard to Copy, 

3. Click your cursor or insertion point in the cell where you want the 

item(s) to begin, 

4. Press your CTRL key and V key on your keyboard to Paste the item(s) 

or text. 

Rig h t  C l i ck  o r  S ho r t cu t  Men u  

1. Select or Highlight your item(s) or cells,  

2. Within the selected item(s) area you want to 

Move or Copy – Right Click (or Secondary 

Mouse Click), 

3. Click Cut OR Copy on the Shortcut Menu, 

4. Right or Secondary Mouse Click where you want 

the item(s) placed, 

5. Click one of your Paste Options as displayed here. 
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Cl ick  a nd  D rag  
(Best for small amounts of data that will not be moved or copied to another worksheet  or 

distant locations) 

1. Select or Highlight your item(s). 

2. Click the selected text, and position your cursor on the border of your 

selection and a four-headed arrow appears for you to click drag it 

where you want to move it and release the mouse button – the text or 

item(s) is moved. 

3. To Copy the Selected Text or Item(s), press the CTRL key on your 

keyboard as you drag the text or Items to the location.  Release your 

mouse button and then release the CTRL key. 

  Care should be taken in click and drag – many a worksheet and cells have been changed 

erroneously because we click and drag without knowing it at times.  But, this is the quick and 

easiest way to move small amounts of data in close proximity of where you want the data 

moved or copied.   

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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Pa s te  Prev iew  and  Pas t e  Sp ec ia l  

Trivia – According to Microsoft studies, the number one 

reason people used the ever popular Undo button was due 

to an improper paste.  So, Microsoft’s Office 

2010/2013/2016 now provides Paste Preview, we may 

view the paste effects before we actual paste. I have 

noticed that while I still rely upon the Undo button for 

many reasons, I don’t use it as much for pasting.  Excel’s 

Paste button on the Home Tab contains a nifty drop-

down arrow with the ability to paste only certain items 

you may want moved or copied, such a values, formulas, 

or transpose.  You can activate the Paste Special dialogue 

box from the Paste button or you can right click and from 

the short cut menu choose Paste special.  The screen that 

will appear if you click Paste Special is 

pictured here. 

 

The default is All under Paste section; however, 

you may only want to paste the Formulas, 

Values, or Formats.  Paste Formats is similar 

to using the Format Painter.    

 

Notice you can paste mathematical operations 

as well. 

 

Transpose is another widely used item.  This 

will take selected rows or Horizontal cells and 

paste them into columns.  Or transpose will take 

columns and will paste them as rows.  This  is great if you decide your worksheet is better suited 

for horizontal layouts if you are using columns or vertical cells.  Or if you decide to turn your 

worksheet from a vertical layout to a horizontal layout transpose makes it easy. 
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Let’s use Paste Preview with Paste Options and Paste Special to change columns to rows and 

to paste only Values of a formula. 

1. In your Budget workbook, click the January 

worksheet, 

2. Select cells A4 through D17, 

3. Click your Copy button, 

4. Click your New Workbook button or CTRL+N 

keys, 

5. In your new workbook, click Cell A4, 

6. Click your Paste Command button’s drop-down 

arrow,  

7. From the drop-down list, hover over the items 

to view your changes as Excel will use Live Preview to 

provide a sneak peek of your various Paste 

Options. Click Transpose. 

8. Your Rows are now Columns and your Columns 

are now Rows 

9. Click Sheet 2, 

10. Click Cell A4, 

11. Click your Paste Icon’s drop-down arrow, 

12. From the drop-down list, view the Value options 

and click Values, 

13. Notice that your formatting disappears and 

notice the Paste Options button at the end of 

your copied area. You may re-paste after you 

pasted! 

14. Click the drop-down arrow on the Paste button here and notice your 

paste options – I clicked the Values and Number Formatting item. 

15. The Paste Options button will change depending what you are pasting 

and where you are placing your information.  
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16. From your Paste button, choose whether you want to keep your 

Formatting. 

17. Click in your Difference column, notice the formula is not present 

(such as =B5-C5) only the Value. 

18. Your Total and Average functions are not present in this worksheet, 

either. 

You may close this workbook without saving it. 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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It ’s  A Setup! Views,  Page Layout and 
Printing 

As you work on your worksheets and especially after your worksheets and workbooks are 

complete, you’ll want to view them in different ways and to print them. Excel has a new view, 

the Page Layout View, and an accompanying Page Layout Tab.  Excel has a View tab as well to 

help with looking at certain parts of a worksheet or switching between workbooks.  The View tab 

displays below and is particularly helpful for large worksheets.   You can quickly turn on and off 

important items on your Excel worksheets, such as gridlines, the formula bar, and headings. 

Your Zoom is here too.   

First, let’s look at the Window Group and Freezing and Splitting worksheets. 

Freeze  tho se  p an es  O r  

I  ha ve  a  Sp l i t t in g  Pane  

If you need to continually view your headings, titles, or other data, as you scoll through your 

worksheet, you can Freeze your panes. If you need to view different sections of your worksheet, 

you can split your panes.  Splitting your rows or columns into panes is similar to having your 

worksheet presented in two or four windows.  Freeze keeps the columns or rows in view at all 

times.    The Freeze Pane Command Button on the View Tab  and the Window Group turns the 

Freeze on or off where your cursor is or which cell, row, or 

column you have selected. The Freeze Pane, Split, and 

other command buttons in the Window Group are pictured 

here.  

 The first step in Freezing and Splitting your worksheet 

is to select the cell, row or column where you want split or 

freeze to occur.   
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 An Important Gotcha!  You cannot split and freeze your panes simultaneously.  

You can either freeze your panes or split them, but not both.       

  

1. With the Track workbook open and in the Jan worksheet, select row 

13 (this is where we want our split), 

2. Click the View Tab,  

3. Click Split button to activate the Split. 

4. Now, you may scroll through two different 

areas of the same worksheet. You can 

compare information at the top with 

information at the bottom of your 

worksheet.  

5. Click the Split button to remove your split screen. 

For practice, click any cell and then activate split. Excel splits your 

worksheet into four panes. Selecting only a row or column provides a 

horizontal or vertical split in two panes.  

 

With our Splits removed, let’s use our Freeze Panes.   

 

A Hot Tip!  You can freeze a cell so that as you scroll your 

left column(s) remain in view AND your top row(s) remain in 
view. You may split your worksheet into four areas by 
selecting a cell and clicking the Split button. Always select 
the cell beneath the row where you want  your freeze/split 
and the column to the right of where you want your 
freeze/split. If you select an entire row or column, Excel 
provides a two pane view for your split and freezes only the 

column or row.  

1. Click Cell D8 in your Jan Tab of the Track 

workbook, 

2. Click your View Tab, 

3. Click the Freeze Panes button and from the 

menu click the Freeze Panes option.  
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4. Scroll to the right notice that the Order, Date, and Customer columns 

remain in view no matter how far you scroll to the right. 

5. Scroll down and notice the your headings remain visible no matter 

how far you scroll down.   

6. To Remove your Frozen Panes, click your Freeze Panes button and 

from the cascading menu, click Unfreeze Panes. 

 

You can freeze specific columns and rows, too.  Click the Column header to the right of 

where you want your columns frozen.  To Freeze a Row click the Row header below where 

you want your frozen row. 

 

Let’s freeze our row headings, so the headings of Order, Date, Customer, etc. remain visible 

as we scroll down. 

1. Click Row Header 8 to select the entire Row 8, 

2. Click Freeze Panes and Freeze your panes again, 

3. Scroll down and your headings above Row 8 continue to display no 

matter how far you scroll down. 

4. Scroll to the right, notice that your columns are not frozen. 

5. To remove the Frozen Row, click Unfreeze panes. 

You may freeze your top row and your left most column using the Freeze Panes menu, but 

these would not help us in this worksheet because our headings are on row 7 and our dates 

and customer names are in the second and third column.  

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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Wh ose  Zoomin ’  who?  An d  o th er  v i ew  

op t ion s  

We have looked at some of the commands on the View tab; here are a few more worth noting, 

especially if you are working on multiple workbooks at once.   

Switching and Arranging  

1. Open several workbook files; I’m opening Budget, Database 

Functionality, and Track. 

2. Click in the Track workbook,  

3. You may quickly activate a workbook by using the 

Switch Windows button on the View tab. 

4. The cascading menu displays your open workbooks. 

From this list you can quickly activate a workbook. 

 

You can quickly arrange your workbooks in various panes by clicking in the Arrange All 

button.  Let’s use this next. 

1. With your multiple workbooks open, click the 

Arrange All button on the View tab. 

2. From the menu, choose your arrangement, I am 

choosing Cascade. 

My workbooks arrange 

in cascading order. Try 

the other 

arrangements to view 

your workbooks. Use 

your maximize button 

to remove your 

arrangement.  

  Hot Tip! Using the cascade and other 

views, you may arrange your worksheets in order to compare 

two different workbooks. You may use the New Window 

button, too.    
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Zooms 
We have looked at the Scrolling zoom lever at the bottom right of the status bar, but the View 

tab has quick ways to Zoom,  too.   

1. With the Track workbook open and in the Jan 

Worksheet select B4 through H5 our bottom line 

results area. 

2. With this area selected, click the Zoom to 

Selection button on the View Tab and the Zoom 

Group. 

3. Wow! Now, you can see your results. 

4. Click the 100% button on the Zoom Group in the 

View Tab. 

5. Clicking the Zoom button allows you to change 

your view by percentages.  

 

New Window and Hide 
The New Window button opens a second occurrence of your workbook, so 

you may compare or work with two different worksheets in the same 

workbook. You’ll need to rearrange your panes and worksheets to view 

them separately. Excel provides a number behind your file name on the Title 

bar. When you close one of the files, you return to one open file without the 

number in the name.  

 

☹ Avoid the Hide button! The Hide button hides your workbook 

(Excel file), not the worksheet. OOPS! ☹ 

 

 Write your notes here:________________________________________________ 

 

________________________________________________________________________ 
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Pr in t  Prev iew  and  Pr in t  

Since Office 2010, Printing, Print Preview, and Page Set-up are easier than ever with the great 

new tri-pane view.  In the past, we had to toggle through Print, Print Preview and Page Set-up to 

customize our printing needs; now, we can accomplish many tasks in one pane – I call this my 

one-stop-shopping for printing.  Printing in Excel can be tricky and cumbersome; I encourage 

you to always Print Preview your worksheet prior to printing them; you never know what you’ll 

get.  With large worksheets you are likely to get blank pages and only 

pieces of information on one page.  You may preview your worksheets 

through the Print Preview and Print button on the Quick Access 

Toolbar or through the File Tab and the Print pane as displayed below. 

Open Track.xlsm file and click the Jan tab. Click the File 

Tab and trace to Print.  Here is the new fantastic Print, Page Setup, and 

Print Preview.   
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What a mess this is; you certainly wouldn’t want to print this in its current state! We can fix 

some of the mess in Print Preview.   

Here are the items we want to change using Print Preview and Print, the Page Layout Tab, 

and Page Set-up. 

✓ Keep the column headers of Order, Date, Customer on each page, 

✓ Have all of the columns fit on one page, 

✓ Change our margins, 

✓ Create new Headers and Footers to display our name, date printed, Page numbers, etc., 

✓ Change where our Page Breaks are, 

✓ Set our Print Area so the blank rows do not print,  

✓ Reduce the number of pages from 6 or so to 2 or 3 ( which the above changes will 

accomplish and save our printer ink and toner and save a couple of trees!) 

I like changing my Margins and column widths in Print Preview.  Let’s change 

our margins and columns widths using the Margins button on your Print 

Preview toolbar. 

1. In Print Preview, click the Show Margins box at the lower 

right corner of your pane,  

2. Your screen will look similar to the one below.  You can resize your 

margins and columns by clicking on the black boxes at the top of the 

screen and moving your double headed arrow to resize the margins 

and columns.  You can also change your Top and Bottom margins, 

too, by clicking 

the lines at the 

top and 

bottom of your 

worksheet and 

with the 

double headed 

arrow click and 

drag up or 

down to 

increase or 
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decrease your margins. 

3. Click on the far left line or box, and when you see the double headed 

arrow, click and drag it over to the left.  Do the same for the right 

margin.  Click the square box at the top of the Customer header and 

drag in and out to see how your columns can resize using the double-

headed arrow.  Resize your margins and columns, until all of your 

columns should fit, now.  When the Paid Column is in view, you have 

fit all the needed information. 

4. Notice on your status bar that the number of your pages will 

decrease.  Great!  We have already reduced our number of pages by 

half. 

 

A Hot Tip!  You can make some of these changes using Print 

Preview and you can click the Page Setup hyperlink on the 

Print Preview pane, but not all of the items that we will need, 

such as Rows to repeat at top and Set Print Area, will be 

active for us.  Using the Page Set-up dialogue box item 

through the Page Layout Tab or the Command buttons on the 

Page Layout Tab are best, so all of the features are available 

for us.  We will use the Print Preview and Print pane from the 

File Tab as well to make adjustments. 

Pressing the CTRL + P keys on your keyboard activates the 

Print Preview and Print pane in the File Tab.  

5. Close Print Preview. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Pag e  La you t  a nd  Pa ge  S e tu p  

Page Layout Tab 

Go to Page Layout tab on your Track and the Jan sheet; this tab is pictured above. You can 

make many changes to your views and prepare your worksheet for printing using the Page 

Layout tab or you may use the Page Setup Dialogue box. 

 

 

These four tabs deserve highlighting.  I will 

mention the most commonly used functions and 

features that will make your Excel viewing and 

printing experience less painful and more 

productive. We will use both the Page Layout Tab 

and the Page Setup box.  We’ll also use the new 

Page Layout View in Excel.  

 

The Page Setup, Scale to Fit, and Sheet Options 

Groups in the Page Layout tab have the Dialogue 

Box launcher as circled and displayed above. In the 

Page tab, you may change from Portrait to 

Landscape if your spreadsheet is more wide than it is 

tall or you may use the Orientation button in your Page Setup Group on the 

Page Layout tab. You may also reduce or enlarge your worksheet(s) using 

the Scaling feature in the Page Tab of your Page Setup dialogue box or use 

the Scale to Fit Group on your View tab.  
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The Paper size appears in your Page tab of the Page Setup dialogue box and on your Page 

Layout Tab on the Ribbon which displays here. The More Paper Sizes item at 

the bottom of the menu opens the Page Setup dialogue box at the Page tab for 

you. 

In the Page tab of the Page Setup dialogue box, you can force your 

information to fit on a number of pages (be careful Excel can force too much 

information on too little space and no one over 40 will be able to read your 

worksheet due to the small size of the font!).  I use the Scaling feature (on the 

Page Setup dialogue box or from the View Tab and scale to fit group) 

frequently for large worksheets and the Fit to feature for smaller worksheets 

(1 or 3 pages).  You may use scaling in your Print Preview and Print pane, 

too.  

 

Also, on the Page tab of the Page Setup dialogue box notice that you can Print your worksheet 

directly from here using the Print button.  You can activate your Print Preview from these 

screens as well through Print Preview button.  The Print and Print Preview button activates the 

Print Preview and Print pane in the File Tab. Finally, the Options button will active your 

Printer’s custom settings.  These buttons appear on all of the tabs for you. 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Margins 

Using the Print Preview and the Margins button is my favorite way of managing my custom 

margins in Excel; however, you can use the Margins command button on the Page Layout tab or 

you may use the Page Setup Dialogue Box and the Margins tab to change your 

margins.  Using the Margins Tab as displayed below allows you to change 

your Margins and Header/Footer print settings here.  As I wrote earlier, I 

prefer using the visual change of settings in print preview; however, I 

definitely like to use the Center on Page feature, especially for small 

spreadsheets that do not cover a whole page horizontally.  This can be helpful.   

 

We changed our margins in Print Preview 

which the numbers are reflected here in 

our Left and Right settings.  We don’t 

need to change these settings. 

 

 

 

 

 

 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Header/Footer 

Headers and Footers are popular in Excel and there are several ways to work with Headers and 

Footers in Excel.  While you may use the Page Setup Dialogue box and the Header/Footer Tab, 

I think you’ll prefer using the new Insert tab’s Header and Footer command button and setting 

your Header and Footer in the new Page Layout View. Your header and footer information 

appears immediately using the Page Layout View; the Page Setup Dialogue box will provide a 

sample but not your actual worksheet and your header/footer information may “run” into each 

other and you wouldn’t know until you go to Print Preview.  

I always include custom headers and footers on my worksheets.  You can use the drop-down 

arrows on the Header and Footer boxes to select preformatted and standard items.  Or choose 

the Custom box to create your own titles and organization of page numbers, dates, file names, 

etc. The Header and Footer Design tab that we will use for our header and footer displays here. 

 

 Let’s create a Custom Header/Footer and use the Insert Tab’s Header and Footer Command 

button and work with the Header and Footer contextual tab of in the Page Layout View. 

1. With your Track workbook open and in the Jan worksheet, click the 

Insert Tab, 

2. Click the Header & Footer button in the Text group,  

3. Excel’s uses the Page Layout view and activates the Header 

and Footer’s Design tab, 

4. Click in the left section of the Header and then click the 

Current Date button and then press space and click the Current 

time to display the date and time that you print this worksheet. 

Excel puts in the codes of &[Date] &[Time]. When you click out 

of that section, your actual date and time appears. 
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 A Hot Tip!  You may go to your Page Layout View using the 

view buttons at the right section of your status bar or using 

the View Tab and the Page Layout button.  Once you are in 

the Page Layout view, you can just start typing in the Header 

or Footer sections and the Header & Footer Tools Design tab 

activates for you.  You may use your Mini Toolbar for your 

formatting, too; simply select your text or items for 

formatting and the Mini Toolbar appears.  

Like the Page Setup dialogue box, you can 

use built in Header and Footers by clicking 

the command button for Header or Footer 

and Excel provides a list from which to 

choose your header or footer.  The Header list 

appears at right. You will want to know how 

to edit and to create your own headers and 

footers. 

1. Click in the center section of your header 

and type: January Results. Click 

and drag to select your text and 

using the floating mini-toolbar 

that appears format your text.  

2. Click in the right section of your header and type the 

word Page and press your Space Bar once, 

3. Click the Page Number command button and Excel enters &[Page] for 

you, 

4. Press your space bar once and type the word of and press your Space 

Bar once, 

5. Click the Number of Pages button and Excel enters &[Pages] for you.  

6. Click away from left section and Excel displays (as an example) Page 1 

of 3. 

Click outside of your headers and the Header & Footer Tools Design tab 

disappears. Now, you may view your information in Page Layout View. 
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7. Click in your Footer section or in the Header & Footer Tools Design tab 

click the Go to Footer button.  

8. Click the Left Section of your Footer, click the File Name button and 

press space and then click the Sheet Name button, Excel enters  &[File] 

&[Tab]. Click away from this section and Excel displays the workbook 

name and the worksheet name. The File Path button lists the 

directories and servers that store the file. 

 

A Hot Tip!  Remember when we selected our worksheets 

to group them?  If you have multiple worksheets and want to 

give them similar Headers and Footers, you could group them 

using the Shift Click method, we studied earlier, and you use 

the Page Layout View and Header and Footers contextual tab 

OR the Setup Dialogue Box and Header/Footer tab to give 

them similar headers and footers.  You do not want to give 

multiple worksheets headers and footers one at a time. If you 

have split or frozen panes, Excel will alert you that it will 

remove these in order to accomplish your Header and Footer 

group.   

Now, in the center section of your Footer enter a disclaimer statement, such 

as Private and Confidential – Proprietary information. 

 

Let’s add a logo or picture to the Footer’s right section. 

1. Click in the right section of the footer, 

2. Click the Picture command button, Excel activates your 

Windows Explorer at your pictures for you to select your logo 

or photo. Navigate to your photo and select it. After selecting 

your photo, Click the Insert button at the bottom of the pane. 

Excel inserts your picture. 

3. Click away from your footer and Excel displays the logo or photo. 

OOPS! Your picture is probably too big for the area. We’ll format our 

picture next. 
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4. Click back into your lower right section of the 

Footer where your picture is and Excel selects 

the code &[Picture] for you. Click the Format 

Picture button circled at right and the Format 

Picture dialogue box appears. I am changing my 

scaling so the photo will fit in the right section 

of the footer for me.  Depending upon the size of 

your photo, you will need to change 

the Height and Width or use the 

percentages for scaling; the default 

size of headers and footers is .5. 

Notice, the Picture tab in this 

dialogue box – this tab allows you to 

change the brightness, contrast, and 

color scheme.  After adjusting your 

size, click OK. Next click away from 

your footer and notice the change. 

 

Those are the six items people usually like in 

headers and footers, where you place these is up to 

you. Here are the items we added: 

✓ Page and Page Numbers, 

✓ A Title, 

✓ Date and Time, 

✓ File and Sheet Names, 

✓ Disclaimer, 

✓ Logo. 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 

  



Page 122 Excelling at Excel: The FUNdamentals Level 1  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2017 
No Duplication Permitted  404-403-5391 

Sheet Options  and Print Areas 

As with other parts of our preparing our worksheets for printing and viewing, we will use the 

Sheet tab in the Page Setup box as well as the Page Layout Tab on the Ribbon to change 

some of the items below.   

Using the Sheet Tab in the Page Setup Dialogue box or the Page Layout tab’s Page Setup 

Group and the Sheet Option Group’s command buttons, you can set your print area and the 

Rows to Repeat at the top of each page.  The Page Setup Dialogue box as pictured below, you 

can use the expand button if you know your print area and rows to repeat you may type them.  

We will make these changes together and notice that Excel will be using absolute reference.   

I like for my headings to appear on every page; 

otherwise, when viewing other pages, I will forget 

what a column signifies and will have to flip back 

to the first page to view my titles.  Many people 

like the Print section to print the Gridlines or the 

Row and Column Headings (these are the number 

for rows and the alphabet letters for columns) in 

the Page Setup Dialogue box or you may use the 

check boxes on the Sheet 

options to view and print 

Gridlines and Headings.   

We learned how to print 

our Comments earlier in 

this course.  Also, if you 

have wide worksheets you would want to change the Page order to Over, then down.  
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Let’s make these changes. 

1. Click the Print Titles button on your Page Layout Tab of 

the Ribbon.  The Page Setup Dialogue box opens at the 

Sheet Tab. 

2. Click in the Rows to repeat at top section, 

3. Click the Row Header 7.  Excels puts $7:$7 in your 

Rows to Repeat at top section, 

4. Click Ok. 

 

☹ The Page Layout View disables Freeze Panes, so you will need to use the Rows to 

Repeat at top in your Sheet options tab. The Page Layout View will keep your column 

headings visible as you scroll through your pages. ☹ 

 

Now, let’s set our Print Area. 

1. Select the area A1 through J95, 

2. Click your Print Area command button on the Page 

Layout tab and from the cascading menu, click Set 

Print Area.  

 

My completed Page Setup Sheet Tab displays at 

right.   

 

1. Click the Print Preview Button. 

2. Scroll through your pages. 

OOPS!  We still have some issues to resolve, 

especially with Page 2.  We need to change the 

page break; let’s make these final changes. 

Save your Workbook.  
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A Hot Tip!  Also, you can print your 

selected area by having the area you 

want printed selected or highlighted 

and then through the File Tab tracing 

to Print and in the Settings section 

choosing Print selection from the pick 

list.   

 

 

 

 

 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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G imme  a  Break  -  Pag e  Break s  

Excel offers a nice Page Break Preview view.  There are three views 

in Excel using your View Tab or Buttons at the right section of your 

status bar – Normal, Page Layout,  and Page Break Preview.   

 

When you choose Page Break Preview, Excel may give the Message 

box displayed at right.  As the dialogue box suggests, we can click and 

drag a dotted line to change the position of your page break (another nice 

Excel feature)!  We’ll do this in a moment. 

 

A Hot Tip!  If you are in Page Break view, don’t forget to 

go to View Tab or use the View buttons on your status bar 

and click the Normal view.  

 

1. In the view tab, click the Page Break Preview button on the toolbar or 

use the Page Break View button on your Status Bar, 

2. You may receive the Welcome to Page Break 

Preview Message box, as pictured above, 

3. Click OK, and you are in Page Break View. 

4. Scroll down and click on the blue Line that 

separates Page 1 and Page 2, 

5. With the double headed arrow, click and 

drag down a few rows, 

6. Scroll down and click on the blue line that 

separates Page 2 and Page 3, 

7. With the double headed arrow, click and drag down a few more rows, 

8. Do the same for columns, if you want all of your columns to fit on one 

page, 

9. Click your Print Preview button, 

10. Click the Next bvutton to view your pages. 
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If all is well, click the Normal view button. It should be ready for printing, 

now. 

 

When you change your Page Breaks in Excel, Excel changes your scaling to accomplish your 

breaks.  My Scale box displays 73% after I changed my Page Breaks.  

You may use your Print Preview and Print screen for scaling, 

too.  

 

You may adjust your pages using the Width and Height 

selections to change the number of pages you wish. 

 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Pr in t  Prev iew  and  Pr in t in g  

After using Page Setup’s Dialogue box, Page Layout Tab and the View Tab, your worksheet(s) 

should be ready to print.  You should check your printing one last time using the Print Preview 

and Print pane.  We have used this for our Margins and scrolling through our pages.  You can 

use the Zoom button in the lower right corner of your pane to Zoom In and Zoom Out of our 

worksheet. Notice your 

scrolling zoom at the bottom of 

the status bar is grayed out and 

cannot be used in Print 

Preview. 

You can quickly access the 

Page Setup Dialogue box 

from here using the Page 

Setup button.  You can 

activate your Print Dialogue 

box by clicking Print button 

here or use the new and 

improve Print pane. 

 An Important Gotcha!  If you click the Page Setup button in Print Preview, your 

Sheet tab will have several areas grayed out, such as Rows to Repeat at Top and Print 

Area.  You cannot make all of your changes if you are in Print Preview using the Page 

Setup dialogue box while your worksheet(s) is in Print Preview   

You can click the Print Button on the Quick Access Toolbar to print your worksheet quickly.  

You can press the CTRL key and the P key simultaneously or click the Print Item under the File 

Tab for more options to activate the Print Preview and Print screen.  Notice you can set the 

number of copies, select your printer, and other items that we have previously learned, such as 

scaling, margins, and orientation. 
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An Excellent Excel  Index  

 

 

= 

=AVG, 71 
=Count, 71 
=SUM, 68 

3 

3-D References, 65 

A 

Absolute Address, 65 
Alignment, 44 
Arrange All, 110 
Autofilter, 24 
Autosum, 68 
Autosum Key, 68 
Average, 71 

B 

Bi-Weekly, 58 

C 

Calculation Box, 17 
Cell, 12 
Cell Referencing, 65 
Cells Group, 49 
Center On Page, 117 
Clear Button, 79 
Column Headers, 11 
Comments, 51 
Comments Group, 51 
Common Tasks And Commands, 36 
Consecutive Numbers, 57 
Copy, 101 
Copy Our Worksheet, 95 
Count, 71 
COUNTA, 72 
Currency, 46 
Custom Filters, 83 
Custom Headers And Footers, 118 
Custom Sort, 90 
Cut, 101 

D 

Database, 74 
Database, 74 
Date Custom Filters, 85 
Days, 56 
Dialogue Box Launcher, 29 
Dr. Fill, 55 

E 

Esc, 19 
Escape Key, 19 
Excel Shortcuts, 15 

F 

Fill Command Button, 55 
Fill Handle, 55 
Fill Options, 61 
Fill With Months And Weekdays, 55 
Filling In A Series Of Numbers, 57 
Fills, 55 
Filter, 79 
Filter Through A List, 75 
Filters And Sorts, 74 
Flash Fill, 61 
Font, 43 
Font Color, 43 
Font Formatting Group, 43 
Format Cells Dialogue Box, 43 
Format Painter, 48 
Formatting, 39 
Formatting Toolbar, 41 
Formula Bar, 11 
Formulas, 63, 64 
Freeze, 107 
Freeze Panes, 108 
Functions, 68 
Functions Keys, 34 

G 

Gridlines, 122 

H 

Header/Footer, 117, 118 
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Headings, 122 
Hide Column Or Rows, 50 
Hide Comment, 53 
Hide/Unhide Worksheet, 95 

I 

Insert, 94 
Insert A New Worksheet, 94 
Insert And Hiding Columns And Rows, 50 
Insert Fill Options Box, 60 

K 

Key Tips, 32 

L 

Landscape, 115 

M 

Margins, 113, 117 
Mathematical Operators, 63 
Merge And Center Icon, 42 
Microsoft Office Button, 9 
Mini Toolbar, 41 
Minimize The Ribbon, 28 
Mixed Address, 65 
Monthly Dates, 59 
Months, 56 
More Functions, 71 
Move Or Copy, 95 
Move Or Copy Your Sheets, 95 
Multiple Filters, 80 
Multiples Of A Number, 57 

N 

Name Box, 11 
New Window, 111 
New Workbook, 39 
Number Custom Filters, 83 
Numbers, 45 

O 

Orientation Button, 115 

P 

Page Break, 125 
Page Break Preview, 125 
Page Layout Tab, 107, 115 
Page Layout View, 107 

Paper Size, 116 
Paste Formats, 104 
Paste Options, 104 
Paste Preview, 104 
Portrait, 115 
Print, 127 
Print Preview, 112 
Print Your Comments, 53 
Protect Sheet, 95 

R 

Relative Address:, 65 
Relative Date, 59 
Rename, 94 
Rename A Worksheet, 16 
Resizing Columns And Rows, 16 
Review Tab, 51 
Row And Column Headings, 122 
Row Headers, 12 
Rows To Repeat At The Top, 122 
Rows To Repeat At Top, 123 

S 

Scale Box, 126 
Screentip, 19 
Scroll Bars, 18 
Scrolling Zoom, 18 
Select All Button, 11 
Select All Sheets, 95 
Sheet Options, 122 
Show/Hide Comment, 53 
Sort & Filter Group, 79 
Sorting, 87 
Sorting By Multiple Items, 90 
Sorting Command Buttons, 88 
Splitting, 107 
Status Bar, 17 
Switch Windows Button, 110 

T 

Tab Color, 95 
Text Custom Filter, 84 
Text With A Number, 58 
The Mini Toolbar, 41 
The Ribbon, 10 
Themes, 47 
Toolbar Options, 20 
Top 10, 81 
Transpose, 104 
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U 

Undo, 50, 88 

V 

View Tab, 107 

W 

Worksheet Navigation Buttons, 13 
Worksheet Tabs, 94 

Y 

Yes/No Filter, 86 

Z 

Zooms, 111 

 


